
Woodworking software for 
designers and makers
Training Course



 
 

 

                           

 

      
ArtCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           1.1 

 



              
 

          

 

                                                                                                                                      
                                                                                                              

 Autodesk 2017   

2                                                                                                                                                                      Copyright © Autodesk                                                                                                                                                       

Important Notice  
 

Welcome to Autodesk.         

This document is supplied as part of an Autodesk Training Course. It is not intended to 

be distance-learning material: rather as an aid for Tutors when presenting material to 

course delegates and as a subsequent aid memoir to those delegates.    

Autodesk does not accept responsibility for any personal belongings / valuables whilst on 

the premises. Delegates are advised to keep their belongings with them at all times.    

Autodesk has no control over the use of the software described in this document and 

cannot accept any responsibility for any loss or damage caused as a result of using the 

software. Users are advised that all results from the software are checked by a competent 

person in accordance with good quality control procedures.    

The software described in this document is furnished under a license agreement and may 

be used only in accordance with the terms of this license.    

Copyright 2016 – Autodesk.  

All rights reserved. 
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Introducing ArtCAM,          

A Flourishing Tutorial 

 

The following tutorial is quick introduction into the world of ArtCAM. 

 

With a few simple steps, an image is imported, traced with vectors, and then modelled 

into a 3D relief. 

 

1 Open ArtCAM  

 

The start up page is displayed. The Open option will load in existing ArtCAM Files and 

import images. 

2 Click Open 

 

 

3 Navigate to the training Data Files and open Flourish-Image.jpg. 
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4 In the Set Model Size screen, choose the Units as mm or inch and change the Height 

as follows then click OK: 

 300 mm or 

 12 inches 

 

 

The image opens in ArtCAM in the 3D View. 

 

 

 

 

The images contains multiple shades of black and white and needs to be reduced to 

allow ArtCAM to quickly trace vector wireframe around the image. 
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5 Open the Bitmap to Vector function  

 

6 Click on the Reduce Colours button. 

  This form allows the number of colours in the Bitmap to be reduced by entering 

the required number or moving the slider bar. 

7 Change the Number of colours to 2 before selecting Apply. 

 

8 Click the Create Vectors button 

 

9 Close the Bitmap To Vector page with the X 

 

Next hide the image and use the vectors to create a 3D relief. 
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10 Click on the Display Material button to hide the image and show the model in ArtCAM 

gold relief colour. 

 

 

 

11 Drag a window with the mouse to select all the vectors. 

12 Open the Shape Editor function  

13 Choose the Round as the Shape Profile. 

14 Then click Apply and Cancel. 
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The relief is now created and visible in the 3D view. 

15 Hide the vectors in the 3D by turning off the Toggle Vector Visibility button  

 

16 Rotate the relief by holding down the mouse wheel and moving the mouse. 

 

 

 

The tutorial is complete! 
 

 

 

 

 

 

 

 

 

 

 



              
 

        ArtCAM Introduction            

 

                                                                                                                                      
                                                                                                              

 ArtCAM 2017  

1.6                                                                                                                  © Copyright 2016 Autodesk, Inc. All rights reserved 

 



 
 

1. Introduction 

                           

 

      
ArtCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           1.1 

1. Introduction 

ArtCAM allows complex reliefs (ArtCAM 3D models) to be created quickly and easily 

from 2D vectors (ArtCAM Wireframe) or bitmaps (Image files). These vectors and 

bitmaps can be generated within ArtCAM or imported from other systems.  ArtCAM can 

also import 3D Surface data, which is translated on entry or after as a Relief model. 

ArtCAM contains tools for editing the reliefs and combining stored reliefs.  Once a 3D 

relief has been created, toolpaths can be generated to machine it. Multiple toolpaths 

are easily generated for roughing, finishing and engraving.  The toolpaths can then be 

simulated to allow complete visualisation of the product before machining. 

 

 

Starting ArtCAM  

 

1 Double click the ArtCAM icon on the desktop  

 

 

 

The initial screen that appears is called the Start Up screen.  To start working, a new 

model can be created, an existing model can be opened, or an image file can be 

opened. Projects are a more advanced option for working with multiple assemblies in a 

3D world. 
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2 Select the Create New Model  

 

 

  A new model must be given a size to work in, an origin position and a resolution.  

 The resolution is the total number of squares or pixels for each axis.  

 

  If you are working with very fine delicate detail, the resolution should be a high 

value. A height of 100 mm with a resolution of 1000 gives 10 bitmap squares per 

millimetre; this is an example of an average resolution. 

Resolution 

 

The dragon model shows the 2D view of the model broken up into a number of squares 

(pixels). Each square is given a height in ArtCAM dependent upon the command used.  

The first relief uses a low resolution, which means a loss of fine detail in the resulting 

3D relief.  

    

If a higher resolution is chosen, the model is broken into many more pixels and 

therefore the fine detail can be shown in the relief. 
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  The trade-off with having a high resolution can normally result in larger file sizes, 

calculation and machine cutting times. 

 

 

3 Decide whether you will work in inches or metric 

 Set the Units to mm, Height and Width to 300mm  

or 

 Set the Units to Inches, Height and Width to 12 

 The resolution should be around 1300 x 1300 points and make sure the origin is in the 

bottom left corner 

 Select OK 

  

The Layout 

 

The entire basic training course is based from the default layout. 

 

From the Window pull down menu, choose Reset Layout, next click on Standard. 

 

ArtCAM opens up displaying the 3D view. You can toggle the views by selecting.  

 

        (or F2 or F3 shortcut key). 

 

The 2D view is traditionally used for designing vectors (2D artwork) and bitmaps 

(images). Reliefs (3D models) created or generated from these entities can be viewed 

in 3D. 

Promoting a more efficient design process, ArtCAM now also allows direct modelling 

from vectors and bitmaps all within the 3D environment. This will be illustrated within 

forthcoming exercises.   
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2D and 3D View Toolbar Functions 

 Isometric View - Default ¾ view when the relief is first drawn 

 View Left - View looking down the X-Axis 

 View Front - View looking down the Y-Axis 

 View Top - View looking down the Z-Axis 

 Scale To Fit Model - Fit the artwork in the view 

 Draw Zero Plane - Toggle visibility of zero plane 

 Origin - Toggle drawing of the origin 

 Toggle Material Block Visibility - Toggles visibility of the defined material         

block for machining 

 Toggle Simulation Visibility - Toggles visibility of the simulation block (from 

machining) 

 Toggle Vector Visibility - Hide and show vectors in the 3D View 

  Display Material – Toggles display of the default material colour   

  Display Bitmap – Toggles display of the active Bitmap colours   

 Contrast - Adjust transparency of Bitmap in the 2D view 

 Toggle Front Relief - Toggle display of the front relief 

 Toggle Back Relief - Toggle display of the back relief 
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Pull Down Menu 

At the top of the Main window, there is a Pull Down Menu Bar. 

 

Clicking on a menu item opens a pull-down menu that contains submenus and 

commands. If a menu item does not apply to the currently active view it will be greyed 

out.  

  Sub menus are indicated and selected via the arrow  at the right hand side 

(where applicable).  

 

For example, the File menu expands to show the following: 

 

A yellow bar highlights the function over which the mouse cursor passes. Left mouse 

button then activates the function. 

On certain commands, the keyboard shortcut is listed next to the description. For 

example, the shortcut to create a new model would be to press the CTRL key and then 

the letter N. 

Toolbars 

The default toolbars are summarised below 

 

The left hand side of the ArtCAM interface is occupied by a vertical Toolbar. This is the 

Design Tools Toolbar. 
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File Toolbar – Contains the standard Windows functionality including the Help 

reference and Options settings. 

 

 

Vector Toolbar - Advanced creation tools for vectors including Offset, Bitmap to vector 

and Nesting. 

 

 

Fill Toolbar - Includes tools to change both vector and relief clipart such as Texture 

Flow and Paste Along a Curve 

 

 

Relief Creation - Tools to create Reliefs including Shape Editor, Weave wizard loading 

reliefs. 

 

 

Relief Editing - Tools to edit a current relief such as Scale, Smooth, Invert, Mirror and 

Offset. 

 

 

Make Toolbar - Tools to create machining toolpaths and export triangular meshes. 

 

 

Flyout Toolbars 

Several icons have a small arrow    located at the bottom right hand corner.  

This indicates that this icon has further hidden functions which can be accessed from a 

flyout. 

 

Select and hold the left mouse button over an icon (with the arrow) will reveal the 

functions in the flyout menu. Releasing the mouse over the desired function will 

activate it. 
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For example selecting the Circle icon from the Design Tools Toolbar reveals the circle 

and ellipse functions. Also selecting Draw reveals the Paint and Paint selective 

functions. 

 

                            

Panels 

There are several different types of Panels in ArtCAM. Panel are the windows or pages 

the functions are displayed on when opened. 

 

Static Panels like the Project Panel are pinned into position. 

 

Floating Panels are for general functions such as Offset Vectors and Extrude. When the 

function is opened, the panel pops up floating on the screen. When finished with the 

function, it can be closed with the  in the top corner. 

 

Flyout Panels remain hidden on the side until pulled out for use. 

 

Project Panel 

The right hand side of the ArtCAM interface is occupied by the Project Panel and several 

Flyout panels. 
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The Project Panel serves as a central area to manage the main design and machining 

aspects of the ArtCAM model.  

When an item is highlighted, the lower half of the panel displays further information in 

the parameters area. 

The main branch of the tree is the name of the file, in this case ‘Model’. If the main 

branch is selected, the parameters area displays the Model Information such as size 

and resolution. 

Each branch of the tree controls a different aspect in ArtCAM. The functionality for each 

sector can be accessed by right clicking on the branch or using the icon in the 

parameters section. 

 

Key areas of Project Tree: 
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Tool Setting Panel 

The Tool Settings Panel is tabbed next to the Project Panel and will appear when its 

associated functions are opened. There are a series of functions located on the Design 

Tools toolbar on the left side of the screen. This series to tools can only be used one at 

a time (for example it is not possible to draw a rectangle and circle at the same time), 

and so they all open on the same Panel, the Tool Setting Panel.  This is very intuitive 

work flow, the Tool Settings Panel will show and hide as each function is opened or 

closed. 

 

 

Tutorial Examples 

These tutorial examples can be accessed when ArtCAM initially starts up. 
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Interface Customisation 

The list of available toolbars and panels can be accessed from the Window pull down 

menu and choosing Toolbars and Docking Windows or by right mouse clicking over any 

active toolbar.   

 

 Also note that the shortcut to hide and show the Project Panel is F4. 

 

Items indicated by the check,  are currently visible. Selecting or unselecting the 

option will toggle its visibility from the interface. The lower half of this menu lists all the 

Panels available in ArtCAM. Selecting/unselecting the  will toggle its visibility. 

 

Selecting Customise will display a new menu which allows extensive customisation of 

the layout. This is outlined below. 

 

 

 Commands - All Commands are listed here. These can be dragged and dropped into 

existing visible toolbars. 

 Toolbars - Toggles Toolbar visibility and ability to create a new customised Toolbar. 

 Keyboard - Keyboard shortcuts can be assigned here. 

 Menu - Options to customise menu including animation. 

 Options - General Toolbar options including Tool tips and icon size. 
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Docking Toolbars 

Toolbars can be dragged into the interface and allowed to ‘float’ in a desired location. 

At the end or top of each toolbar there is a solid line.   

When the mouse cursor is placed over this line, it changes to a cross  at which point 

the toolbar can be selected and dragged. 

 

Docking Panels 

When a Fly out Panel is pinned, it also can be dragged (to float) or docked in a fixed 

position at each end of the screen. 

Select and Hold the mouse cursor in the top margin to drag the Panel into the screen.  

 

 

Whilst dragging, the interface displays a cursor pad in the centre and edges of the 

page. Depending on which arrow the panel is moved over, the screen will display a blue 

region where the panel will dock. Release the mouse button to dock the panel in this 

location.   

 

 

Panels can also be docked onto the top or bottom half of other fixed Panels or 

appended by a tab at the bottom. This is achieved by dragging a panel (as described 

above) onto another Panel to activate the ‘cursor pad’. 
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Layout 

 

From Window > Reset Layout…… 

 

Select Reset Layout to quickly reset the interface to default settings. 

 

ArtCAM Help 

 

By selecting Help > Index from the top Menu bar (or by pressing the F1 shortcut key) a 

Help Page will open over the graphics area. 

Further sources of information and help can be obtained from the ArtCAM website and 

dedicated Forum.  

 

 

 

Individual function forms can be expanded to provide a detailed explanation of each 

available option/entry. 

 

This is achieved by selecting the Help icon  in the top right hand corner of the active 

form. The example below applies Help to the Rectangle Creation function.  
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ArtCAM Files  

An ArtCAM Model (.art) will contain all entities created within the session such as 

Bitmaps (image files), Vectors (2D geometry) Reliefs (3D models) and Machining data 

(Toolpaths). This ArtCAM file is identifiable by having an .art extension and can be 

saved or exported as a whole. 

 

It is also possible to save/export and import independent entity types from within the 

ArtCAM Model. These include the Vectors (mainly .eps .dxf .dgk .pic formats), Reliefs 

(.rlf), Triangle Models (.stl .dmt) and Machining Output (.tap,...). 

 

For more advanced applications where it is required to create an assembled group of 

separate Relief models (.rlf), an ArtCAM Project is first opened in which several ArtCAM 

Models can be created and combined as required for an assembled item. When saved, 

the Artcam Project is identifiable by a (.3dp) extension. To enable the Reliefs to co-

exist together, the individual components are converted within the Assembly as 

Triangle Mesh models. ArtCAM can also import surface models (e.g. iges) directly into 

an assembly. 

 

 



              
 

        1. Introduction            

 

                                                                                                                                      
                                                                                                              

 ArtCAM 2017  

1.14                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

Design 

ArtCAM Reliefs (*.rlf) or simply the 3D models are created from 2D vectors or bitmaps. 

These vectors (2D artwork) and bitmaps (images) can be generated within ArtCAM or 

imported from other systems. ArtCAM can generate reliefs from an imported model.  

When dealing with bitmaps and Reliefs it is important to understanding Resolution, 

which will influence the overall surface detail of the relief and ultimately the final piece. 

Manufacture 

The final stage for most ArtCAM Projects is to manufacture the 3D relief as a real 

object. Currently there are two major routes to production: via CNC machining or Rapid 

Prototyping. ArtCAM can realise its models using either method. 

 

ArtCAM can calculate the toolpaths required to machine the individual relief or final 

assembly. The calculated toolpaths can be then sent directly to the machine (via post-

processing) ready for cutting. 

 

Mouse buttons application 

Each of the three mouse buttons performs a different operation in ArtCAM’s 3D View. 

By using the ALT, Ctrl or Shift key on your keyboard, these operations can be extended 

as the following details explain. 

Left mouse button: Picking and selecting 

 

This button is used for selecting items off the main pull down 

menus, inputting data and selecting parts of the model. 

 

Middle mouse button or wheel: Dynamics 
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Zooming: Scroll the middle mouse wheel to Zoom IN/OUT of the model. This applies to 

the 2D and 3D view. Alternatively, Select the SPACE BAR and Right mouse button 

together and move the mouse to Zoom IN/OUT. This second option applies to the 3D 

view only) 

 

Panning: Hold down the Left and Right mouse buttons and                                      

move the mouse, to move the view across the component. 

 

 Rotating/Twiddle: Hold down the middle button/wheel and move the mouse. 

Alternatively Select the SPACE BAR and Left mouse      button together and move 

the mouse. This second option applies to the 3D view only) 

 

 

Functions – Additional Functions 

 

 New Model - Create a new blank ArtCAM Model 

 Open File - Open an existing ArtCAM file or image (.art, .bmp, .jpg, .rlf, …) 

 Save - Save the current ArtCAM model 

 Cut - Move the currently selected object to the clipboard 

 Copy - Copy the current item onto the clipboard 

 Paste - Copy the current item on the clipboard into the model 

 Undo - Undo the last command 

 Redo - Redo the last undone command 
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Functions – Tips 

 

Import Vector - Import vector artwork (.eps, .dxf, .dwg, .ai, .pic, .wmf, .dgk). 

This function is available from the Vector pull down menu. 

 

Export Vector - Save a copy of the selected vector (.eps, .dxf, .dgk, .pic) 

This function is available from the Vector pull down menu. 

 

Help - Launch ArtCAM's online help 

 

ArtCAM Notes - Add written notes to the current ArtCAM file, this function can also be 

accessed by pressing ALT-N 
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2. Basic Vector Creation 

Introduction 

This chapters gives a simple introduction to creating vector shapes. 

 

Functions 

The Vector Creation functions are available on View Tools Toolbar. 

   Polyline Creation - Create vector polylines, straight or curved 

   Rectangle Creation - Create vector squares and rectangles 

   Circle Creation - Create vector circles 

   Ellipse Creation - Create vector ovals 

   Polygon Creation - Create vector polygons 

   Star Creation - Create vector stars 

   Arc Creation - Create vector arcs 

   Text Tool - Create vector text   

Text on a Curve function is available on Design Tools Toolbar, in the Text flyout. 

   Bitmap to Vector - Trace primary (current) colour with vector curves 

 

The Ellipse Creation and Circle Creation functions are under a single flyout menu. 
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Polygon Creation and Start Creation functions are under a single flyout menu. 

 

Example 2-1: Rectangle Creation 

Follow along with the teacher to complete Example 2-1. 

 

Notes for Example 2-1 

 

Create Rectangle will be used as an example to explain the basics of all vector creation. 

1 Open the Create Rectangle function from the Design Tools Toolbar  

 

The Tool Settings Panel appears on the Right Side in the hidden stage.  

The rectangle can be created by clicking in the screen and dragging to a size, or by 

entering in specific values. 

 

 

Several rectangles can be created without closing down the function. 

 

The Tool Settings Panel has help available, indicated by the   Help Icon. 
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2 Click the Help question mark at the top of the Rectangle Creation panel to hide and 

show the help 

 

The Panel displays help at the side of each option. 

This increases the length of the page and you may have to move the page down to see 

further instructions, by using the scroll bar. 

 

 

Once help is switched on it is displayed for each command. To switch this off, you need 

to click the Help Icon. 

 

3 Click the Help question mark Icon to Hide Help 

 

4 Hold down the left mouse button in the 2D view and drag a rectangle of any size 

5 Release the mouse button when satisfied with the size 
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The rectangle appears as dotted. The length and height can be dragged by moving the 

big squares in the middle of the sides. A radius can be put on the corners by dragging 

in one of the corners. 

 

The rectangle can be rotated by dragging around the lever in the center. 

 

6 Right Click when you are done creating 

 

Right clicking is one of the methods to close or complete the Create Rectangle function. 

You can also press Esc or click on the Select vectors icons to close the function. 

 

The different ways to draw vectors: 

 Drag the mouse to draw 

 Type in specific values  

 Drag to draw then adjust values by typing 

 

The different ways to create and close  

 When draw free hand, show how to continue to draw others 

 Close the Create Rectangle function by Right clicking  

 Close by clicking on Create and Cancel 

 

 

Polyline: 

There are two basics ways to draw a polyline.  You can take the mathematical approach 

and type in exact values; absolute coordinates, incremental length & angle or 

incremental distance X & distance Y.  The other option for drawing a polyline is to hand 

sketch it.  If you click on the 2D View, you can draw a line, if you hold the mouse 

button down and drag it, you can draw free-hand. 
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Tutorial: Vector Shapes 

This project will go through all the basic vector creation tools. 

 

On the diagram, all dimensions are marked next to the shapes.  The center: (_,_) are X 

and Y coordinates.  

 

 

1 Create a New Model 775mm x 775mm (30” x 30”) 

2 Origin in the lower left corner 

3 Create the following shapes as shown on the diagram on the following pages: 

 

 Chose to work either from the MM below or INCH diagram on the 

following page. 
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Wrap the ‘ArtCAM Delcam’ Text onto the ellipse 

4 Open the Text tool and click on the Text, Select Ellipse and click Select Curve in the 

Text Tool page 

5 Try various options in Text On A Curve function 

 

 

Example 2-2 

 

Follow along with the teacher to complete the Example. 

 

Bitmap To Vector: 

This tool automatically traces a vector around the selected primary colour. The bitmap 

or image colours can reduced, merging together similar shades until they are 

condensed to a few main colours for tracing. 
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3. Vector Tools 

Introduction 

 

This section will run through how to use most of the vector editing tools.  It will start 

with the basics, such as selection modes and cursor types and then go into more 

complex editing tools. 

 

Note, shortcuts are listed in brackets following the function description. 

Functions 

   Select mode - Default mode for standard vector work and multiple vector 

selection (Esc) 

   Node Editing mode - Edit the nodes and spans of a vector (‘N’) 

    Transform Vectors mode - Transform (rotate, move, scale, shear etc.) 

currently selected vectors (‘T’ to enter mode, ‘TT’ to open Transform function) 

   Group Vectors - Group a selection of vectors 

   Ungroup Vectors - Ungroup a previously grouped set of vectors 

   Vector Doctor - Fix loops and identifies coincident points on a vector 

   Spline Vectors - Smooth selected vectors by fitting curves and reducing nodes 

   Block and Rotate Copy - Copy vectors in rectangular or circular array 

   Centre In Page - Align selected vectors to centre of page (F9) 

   Mirror Vectors - Mirror selected vectors 
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   Offset Vectors - Offset currently selected vectors inwards or outwards 

   Fillet / Extend Tool - Radius a corner or extend two vectors to meet 

   Trim Tool - Trim vector to intersection of another vector 

   Weld Vectors - Combine selected vectors by merging together and keeping 

outside 

   Join Vectors With A Line - Join two selected vectors with a straight line 

   Join Vectors With A Curve - Join two selected vectors with a smooth curve 

    Join Vectors by Moving Ends Nodes - Join two selected vectors by moving end 

points together 

   Close Vector With A Line -Close a selected vector with a straight line 

   Close Vector With A Curve - Close a selected vector with a smooth curve 

   Close Vector Move End Nodes - Close a selected vector by moving end points 

together 

   Join Multiple Vectors - Join multiple vectors with coincident start or end nodes 

   Nesting - Nest multiple vectors inside a boundary 

   Reduce Colours - Reduce number of colours in the model. 

   Bitmap to Vector - Trace primary (current) colour with vector curves 

 

Some functions are grouped together in flyout toolbars and others are found in the pull 

down menus:  
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Importing Vectors: 

Vectors can be imported in 2 different ways, through the Vector pull down menu and 

through the Vector Layers. 

Vector pull down menu: When importing through the Vector pull down menu, it will 

import the vectors onto the current Vector Layer. Also if there were layers on from the 

original file, the separate layers will be preserved. 

Vector layer: When importing from the Vector Layers, it will create a new vector using 

the name of the original file and import the vector onto this new layer. 

 

 

Example 3-1 

Follow along with the teacher to complete the Example. 

 

Offset Vectors: 

Radiused keeps the exact same distance throughout the entire offset, causing a sharp 

corner to become radiused.  Sharp has the Max Sharp Offset Distance option which the 

default is 100%.  This is used as a limiting factor in case an offset corner is too long at 

which time it chamfers the corner.  If it chamfers a corner to soon, increase the value 

to 200% or 300%. 

 

 

Example 3-2 

Follow along with the teacher to complete the Example. 

 

Vector Doctor: 

Identifies both loops and coincident nodes (nodes on top of each other), but will only 

remove loops.  To fix coincident nodes, remain in Vector Doctor, enter node editing 

mode, and delete nodes. 

 

Mirror Vectors:  

When using About Line, B mirrors about A, select the line and then the object.  

 

Shortcuts: 

Ctrl  holding Ctrl while moving a vector, leaves a copy of the original. 

Alt  holding Alt while moving a vector, keeps it parallel to the X or Y axis. 

Use both at the same time to make a copy of the vector that lines up with the original. 
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Example 3-3 

Follow along with the teacher to complete the Example. 

 

Vector Editing: 

All standard vector shapes can be edited using the original creation screen. Standard 

vectors include rectangle, circle, ellipse, polygon, star, and text.  Select the vector and 

press ‘E’, where 2D Shape will be rectangle, circle, … etc.  The polyline and arc tools 

cannot be edited.  Also if the vector has been changed through node editing or 

transform, it can no longer be edited. 

 

Selection Modes: 

 Selection mode  Default mode.  Press Esc key to enter mode.  Selected vectors 

are pink.  Can select multiple vectors.  Many functions require this mode to work.  

 Node Editing mode  Press ‘N’ to enter mode.  Selected vector is colour of layer.  

Can only select one vector at a time.  All node and span editing is done in this mode.   

 Transform mode  Press ‘T’ to enter mode.  Press ‘TT’ to enter mode and open 

Transform Vectors function within the Tool Setting Pane.  Selected vectors are the 

colour of the layer.  Can select multiple vectors.   

 

 

Cursors: 

 Selection mode cursor  Standard cursor when in vector Selection mode. 

 Move Vector cursor  Vectors can be moved when this cursor is visible. 

 Node Editing mode cursor  Standard cursor when in Node Selection mode. 

 Span cursor  Available in Node Editing mode, when hovering over a span. It  

has a specific right mouse click menu to edit spans. 

 Node cursor  Available in Node Editing mode, when hovering over a node. It  

has a specific right mouse click menu to edit nodes. 
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Object Snap Cursors: 

 Snap to node. 

 Snap to mid node of line. 

 Snap to centre of bounding box. 

 Snap to X axis of start node (for polyline creation only). 

 Snap to Y axis of start node (for polyline creation only). 

 Snap to horizontal Guide Line. 

 Snap to vertical Guide Line. 

 Snap to intersection of horizontal and vertical Guide Lines. 

 

 

Node Editing 

The structure and appearance of a vector can be changed using the Node editing 

options. Vectors are made up of nodes and spans which are displayed only when 

ArtCAM switches to Node Editing Mode.  

 

Upon selecting a Vector, Node Editing can be entered by selecting  from the 

Design Tools Toolbar on the left hand side, the Right mouse select menu or simply 

selecting N on the keyboard. 
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3. Vector Editing 

                           

 

      
ArtCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           3.7 

Tutorial: Birthday Card 

 

Introduction 

Vector creation will be introduced with the design of a simple Birthday Card for 

engraving purposes. Functionality demonstrated will include the Vector creation tools, 

Text on curve, Node Editing, Block Copy/Rotate, Transform Vectors, Paste along Curve 

and Importing of Vectors.  

 

 

1 Open New Model.  

2 Enter a Height 200mm (8”), with a Width 150mm (6”). 

 Set the Origin to the centre of the model and a resolution of approximately 

1056x1408 points (by moving the slider). 
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A new ArtCAM Model (sheet) is generated based on the parameters defined above. 

 

Creation tools and various other design commands can be accessed in a number of 

different ways. For this exercise the Design Tools toolbar on the left hand side of the 

screen can be used. 

 

Create Boundary and Balloons 

The outline of the birthday card will be created first. 

1 Using a method outlined above, open Create Rectangle.  

 

The Rectangle Creation form appears in the Tool settings panel. 

 

2 Enter a Width 130mm (5”), a Height 185mm (7.25”), Corner Radii 0mm and a Centre 

Point X 0 and Y 0. 
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3 To create the shape and close the function, single right mouse click in the main 

window. 

  The rectangle is created on the model page and the Create Rectangle function is 

closed. 

To create the shape whilst keeping the rectangular creation form open, single left 

mouse click in the main window. This can be utilised to create additional 

rectangular shapes. 

4 Open Create Ellipse.  

5 Enter a Start Point X -5 (-0.2”) Y -5 (-0.2”) with a Width 30mm (1.2”), Height 40mm 

(1.55”), and an Angle 0 degrees.  

6 Right mouse click to create the shape and close the form. 

 

This creates the first center balloon. The other 2 balloons will be the same size, 

positioned behind the first one. Instead of creating and positioning 2 new ellipses, 

we can simply copy the existing ellipse. 

 

7 Select the ellipse and hold the Ctrl key, and drag the balloon slightly up and to the 

right. 

8 Repeat and hold the Ctrl key again, this time dragging to create upper left balloon. 
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Create Text 

1 Open Create Polyline.  

 

  Polylines can be generated by entering absolute co-ordinates in the X and Y area, 

by angles and line length and as relative co-ordinates using the dx and dy 

(distance from last point) or by clicking with the cursor. 

Polylines can also be created dynamically in the graphics area either by holding 

down the left mouse key for freehand sketching, single left mouse clicks to create 

straight lines.  

Sketching smooth curves will be illustrated below. 

 

2 Check the option Draw smooth polylines.  

 

3 Left mouse click 4 suitably positioned points  to generate a Smooth Polyline as 

shown. 
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4 Repeat to create a second polyline as shown. 

  Pressing the Space bar on the keyboard will complete the first polyline but keep 

the form open to start a new one. 

5 Open Create Vector Text.  

6 Select a preferred font and size or use the following settings. 

 

7 Font as Snap ITC, Script as Western, Size 10mm (0.375”) and Character Spacing 50%. 

8 Select the top Polyline you have created and under the On a Curve section in the 

Text Tool click Select Curve 

 

9 Type the word Happy. 
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10 Select Create on the text form to create the text and close the form. 

 

 

11 Repeat the above to create the word Birthday! On the second Polyline 

12 Click Create  

 

 

13 Delete the original two curved polyline vectors to leave the following result. 

 

 

Create Cake 

1 Open Create Ellipse.  

2 Enter a Start Point X 30 (1.2”) Y -60 (-2.36”) with a Width 45mm (1.75”), Height 6mm 

(0.25”), and an Angle 0 degrees 

3 Right mouse click to create the final shape and close the form. 

4 With the ellipse vector highlighted, Open Node Editing.  

 

  Node Editing is a powerful tool which allows the structure and appearance of a 

vector to be changed easily. Node Editing will be shown in greater detail in the 

next chapter (Chapter 3). 
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The ellipse shape will be split into two halves. This can be achieved in Node Editing by 

cutting the vector at the end node points. 

 

5 Move the mouse cursor directly over the right hand blue node. 

6 Right mouse click and select Cut vector from the local menu. 

 

 

The node itself changes colour from blue to black. 

  

7 Repeat the above to Cut the left hand blue node 

8 Exit Node Editing by selecting Esc or N on the keyboard. 

9 With only the Lower Ellipse selected, click on the Block and Rotate Copy  from 

the Fill Tools Toolbar. 
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The Block and Rotate Copy allows you to create a block copy in X and Y or a rotated 

copy around a point. 

The distances can be set as centre offset value or by a gap value between each item. 

 

10 Open Block Copy and choose Distances are offsets options. 

11 Select an X Offset 0mm, and a Y Offset -7mm (-0.275”)  

12 Number of Columns as 1 and, with Number of Rows as 4. 

13 Select Apply and close the panel using the X in the top right corner. 

The lower vector has been copied into 4 rows to create the birthday cake. 

 

14 Snap a single polyline from the bottom of each balloon ellipse to the left hand corner 

of the cake ellipse as shown below. 

 

 

15 Open Trim Vectors  from the Vector Creation Toolbar. 

16 The internal vectors representing the balloons will be removed using this tool. 

 Select the inner ellipse and polyline vectors to trim as indicated. 
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Candles will now be created for the cake itself. 

 

17 Create a Rectangle  with a Width 10mm (0.375”), Height 30mm (1.2”), Corner 

Radius 0mm and a Centre Point X -50 (-2”)  and Y -50 (-2”). 

18 Create a Circle  with a Centre Point X -50 (-2”), Y -31 (-1.25”) and a radius 

4mm (0.15”). 

19 With the new circle selected, enter Node Editing  

 

20 Use the cursor to select and dynamically drag the top node upwards as shown. 

 

 

21 Drag the upper control point (white squares) of the right hand node inwards to 

create a flame effect. 
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22 Exit Node Editing. 

23 Select the rectangle and ‘flame’ vector and then open Transform  (or hit T on 

the keyboard). 

 

 

 

24 Change Scale to percent % and ensure both width and height are linked. 

25 Change the Scale to 25% and then press Apply.  

Both vectors are relatively scaled down to a realistic size, and will now be moved into 

position. 

 

26 With both vectors selected, dynamically drag the vectors onto the cake as shown. 
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 Multiple copies of vectors can quickly be achieved by using/holding the CTRL key.  

 

27 Ensure both candle vectors are still selected. 

28 With the Ctrl key pressed, use the left mouse to select and drag a new copy of the 

candle to a suitable position on the cake. 

 

29 Repeat three more times to produce a total of 5 candles. 

30 Use Trim Vectors  to remove the small ellipse vectors passing through the 

candles. 
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Create Year Number 

  

1 Open Create Vector Text  and apply the following settings.  

 

 

 

2 Use a text size 25mm (1”). 

3 Position the cursor in the bottom left area of the model and enter the number 5. 

 

 

4 Open Create Circle.  

5 Move the cursor over the centre of the number 5 until it changes to an  icon 

indicating the centre is located. 

6 Drag out a circle to approximately 25mm (1”) radius. 
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7 Create a Star vector  with the following settings. No of points 5, star centre at 

X -10 (-0.375”), Y -80 (-3.15”), Radius of first points as 5mm (0.2”) and second 

points as 2mm (0.075”). Click Create and Cancel 

 

 

8 Shift-select the star and the large circle vector around the number 5. 

9 From the Fill Tools toolbar, open Paste along Curve.  

 

The vector is pasted incrementally along the curve either by dividing the curve 

equally (Specify Number), or by a fixed distance, leaving any surplus at the end of 

the curve (Specify Distance). 

 

10 Select Specify Number and enter Number of Copies as 5. 

11 Select Paste. 

12 Delete the original Star vector and the large circle. 
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The card will be completed with an imported border feature. 

 

13 Select and delete the large original border rectangle. 

 

Vectors can be imported by using either the vector layers toolbar (to be discussed 

later) or from the main pull down menu. 

 

14 From the pull down menu, select Vectors and then Import. 

 

 

 

15 Browse to and open border feature.eps. 

16 (The design is imported into the current model and completes the design). 

17 Select File > Save As and enter the name Birthday Card and then Save. 

18 Select File > Close Model. 
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Example 3-4 

Follow along with the teacher to complete the Example. 

 

Layers: 

Vector Layers provide a more ordered method of managing the selection and display of 

selected groups of vectors. In default mode, ArtCAM assigns all vectors produced to a 

layer named the Default Layer (which cannot be deleted). Any additional Vector Layers 

can be Renamed, Deleted and Merged together. As new Layers are created, specific 

group of vectors are assigned to them as required.  

 

Vector Layers within ArtCAM can be managed in a number of ways. The most common 

is Through the Project Panel. 

 

 

 

 

The Project panel allows for an efficient flow for creating and managing all major design 

and machining aspects of the ArtCAM model. 

 

 

Example 3-5 

Follow along with the teacher to complete the Example. 
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Summary Tutorial: Welcome Plaque 
Students are to complete tutorial. 

 

Welcome Plaque Border Image 

1 Open base.jpeg  

 Width of 1220mm (48”), Origin to lower left corner 

2 Bitmap to Vector 

 Reduce Colours - 3 

 dark blue as the primary colour.  

 Create Vectors  

3 Click on lightbulb  to hide Bitmap Layers. 

 

Welcome Plaque Vector Layers 

4 New Vector Layer    

5 change name in lower panel to border then Apply 

6 Select border vector and right click, Move Vectors To…   border 

 

Welcome Plaque Border 

7 Delete outer rectangle vector and small cluster of vectors.  

8 Node Editing - Cut Vector 

9 delete large vector to leave only bottom left vector. 

                     

10 Mirror Vectors   

 Check Copy and Join 

 Mirror Right   

 Mirror Top 
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11 F9  

Welcome Plaque Scroll 

12 Bitmaps Layers - Import Image  - scroll single.jpeg  

13 New Vector Layer 

 Rename - scroll 

 

14 Bitmap to Vector 

 Reduce Colours - 2 

 dark blue as primary colour.  

 Create Vectors  

15 Hide Bitmap Layers  

 

16 Transform Vectors - scroll 

 scale 150% and Apply. 

17 Spline Vectors   

 Tolerance 1 (0.05”)  

18 Mirror vectors 

19 Copy - Right 

 

20 Use arrow key to nudge until they slightly overlap 

 

21 Weld Vectors 

22 F9  

23 Alt and drag it down towards bottom  

24 Mirror Vectors  - Over Model 

 

Welcome Plaque Design 

25 Bitmap Layers - Import  - welcome bird.jpeg. 

26 New Vector Layers and Rename it to design 

27 Bitmap to Vector 

 Reduce Colours - 2 

 black as the primary colour.  

 Create Vectors  

28 Hide the Bitmap Layers  
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29 Transform Vectors 

 scale to 120% and Apply  

 Unlock Maintain aspect ratio  

 New Width to 900mm (35.5”) 

 

 

 

30 New Vector Layers - Rename it to text 

31 Create Vector Text.  

 Font Showcard Gothic, Size 90mm (3.5”) and Character Spacing of 160%. 

 Type WELCOME 

32 Drag to position  

 

33 Activate the border Vector Layer  

 

34 Offset Vectors  - border 

 distance 20mm (0.75”) Outwards with Sharp corners. 

 

35 Change Vector Layer colours 
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Tutorial: Welcome Plaque 

The second tutorial demonstrates further functionality to create a Welcome Sign/Plaque 

as shown below. Additional tools shown include Offset Vectors, Weld Vectors and Mirror 

Vectors. 

The main design features are generated using Imported Bitmaps. Reducing colours of 

an imported Bitmap and the powerful Bitmap to Vector will be utilized extensively. 

 

 

Welcome Plaque Border Image 

1 Select Open to open an existing model.  

2 Change Files of type: to Bitmap Files. 

 

3 Open the file plaque base.jpeg. 

4 Enter a Width of 1220mm (48”). 

5 Set the Origin to the lower left corner of the model then OK. 
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The design can done from either 3D View or 2D View. To switch between views, click on 

the appropriate tab above the view. 

 

A new model is generated from the Bitmap based on the dimensions. ArtCAM displays 

all the colours that make this Bitmap at the bottom of the screen. The number of 

colours will firstly be reduced to a manageable level. 

 

 

The Bitmap To Vector  feature calculates the vector boundary of the selected 

primary colour in the bitmap image.  This will be utilized to generate the outside 

boundary of the plaque border. 

 

  Bitmap or image colours can be reduced using the stand alone function Reduce 

Colours  or directly within the Bitmap To Vector function. 

 

6 Open Bitmap to Vector.   
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7 Click on the Reduce Colours button. 

This form allows the number of colours in the Bitmap to be reduced by entering the 

required number or moving the slider bar. 

8 Change the Number of colours to 3 before selecting Apply. 

 

The colour palette now shows the only three colours that represent the Bitmap. 

 

9 Click on the dark blue colour directly from the palette to assign it as the primary 

colour.  

 

10 With the default settings shown above, Select Create Vectors then close the panel. 

 

 

A vector has been generated on the boundary of the selected primary colour. The 

Bitmap is not required so will be hidden. 

 

11 In In the Project tree, click the plus + next to Bitmaps to display the Bitmap Layers. 

12 Click on the lightbulb  to hide the Bitmap Layers. 
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Welcome Plaque Vector Layers 

The vector data is currently on the Default Layer. The visibility can be shown and 

hidden by selecting the light bulb  adjacent to the Default Layer name. 

 

Ideally Layers should be generated before vector creation so they can be placed into 

them. It is good practice to give the layer a sensible name. If a new layer is created 

and then made active (by selecting it), all newly created vectors are placed on this 

active layer.  

However, a Vector Layer can also be created afterwards and the vector moved to the 

new layer. 

 

13 Ensure the Default Layer is selected in the project panel 

 

14 Select New Vector Layer  in the lower panel 

 

 Vector Layer 1 has been created and added to the Vectors tree. 

  

15 Select Vector Layer 1, and change the name in the lower panel to border then Apply 

 

 The new level is now named and visible (denoted by the light bulb icon).  

 

The existing vector can now be moved to the new layer. 

 

16 Select the border vector and right click with the mouse. 

17 Select Move Vectors To…   border 
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Welcome Plaque Border 

 

1 Delete the outer rectangle vector and small cluster of vectors indicated.  

 

The original Bitmap of the Plaque border is not symmetrical, so the above vectors will 

be modified to ‘improve’ the final design.  

 

2 With the border vector selected, enter Node Editing.  

 

 

 

 

3 Zoom into the area indicated with the number 1 

4 Right mouse click over the left corner node and select Cut Vector.  
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5 Zoom into the area indicated as 2, and Cut the lowest corner node as shown below. 

 

6 Pres Esc to exit node editing. 

 

The lower left section of the initial plaque vector has been seperated at the node cut 

points. 

 

 

7 Select and delete the large vector to leave only the bottom left vector. 
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The plaque vector will be recreated symetrically using this vector.  

 

8 Highlight the remaining vector and open Mirror Vectors  from the Vector 

Editing toolbar. 

 

 

9 Ensure Copy the Original Vectors is checked, as well as Join mirrored vectors before 

selecting Right (Do not close the form). 

 

 

The vector has been mirrored to its right hand side. 
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10 Select Top to mirror this new vector upwards. 

 

 

11 Close the Mirror Vectors panel. 

12 With the vector still selected, Select Centre in Page  or F9 on the keyboard. 

 

The inner plaque design will now be completed. 

 

 

Welcome Plaque Scroll 

1 Select to highlight Bitmaps in the Project Tree, then Import Image  from the 

associated lower panel. 

2 Select file scroll single.jpeg and open. 

 

 

The bitmap is loaded into the current model and listed in the Bitmaps Project tree. 
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3 Right click on Vector Layers in the Project Tree and select New  

4 Right click the new Vector Layer 1 and choose Rename. Call this new layer scroll. 

 

Scroll is the current active vector layer, any vectors created will be drawn on the Scroll 

layer.  

 The bold layer is the active layer 

 

 

 

 

Next the colours will be reduced and traced. 

 

5 Open Bitmap to Vector.   

6 Click on the Reduce Colours button. 

7 Change the Number of colours to 2 before selecting Apply. 

8 Click on the dark blue colour directly from the palette to assign it as the primary 
colour.  

9 Select Create Vectors and close the panel. 

10 Hide the Bitmap Layers by clicking on the light bulb in the Project Tree. 
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11 Select the new scroll vector and then Open Transform Vectors.  

12 Increase the scale to 150% and then Apply. 

 

The vector has increased in scale by 50%. The smoothness of the curves can be 

improved even further by using Spline Vectors, but this is not necessary. 

 

13 Highlight the scroll vector and then Open Spline Vectors  (listed with the Arc 

Fit tool). 
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The Vectors information area summarizes the number of spans that represent the 

selected vector. Currently, the scroll vector is made up of 44 Bezier curves, 2 lines and 

134 points. 

By adjusting the tolerance, the spans will recalculate to produce the shape based on 

this new fitting tolerance. In this instance, the tolerance will be increased to smooth out 

the overall shape. 

 

14 Enter a Tolerance 1 (0.05”) and press Spline. 

Total number of span has been reduced to 26 and points to 78. (slightly different if 

using imperial units). This also makes it easier to edit the shape in Node editing  as 

the number of nodes are reduced. 

15 With the same tolerance, select Spline again. The shape will improve slightly further 

as the points are redistributed. 

16 Close the panel. 

17 With this vector highlighted, Open Mirror vectors . 
 

18 Ensure Copy the Original Vectors is checked, before selecting Right.   

19 Close the panel. 

 

 

The two vectors will be combined to create a single design. 

 

20 Select the right hand side (mirrored) vector only and use the arrow key on your 

keyboard to nudge it left until they slightly overlap. 

 

 

 

21 With both vectors selected, open Weld Vectors  . 
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The overlap is removed to create a single closed vector. It will now be moved to a 

suitable position. 

 

22 With the scroll selected press F9 to center it. 

23 Hold the Alt key and drag it down towards the bottom as shown. 

 

The Alt key will hold the vector straight while moving it. 

 

 

 

24 Select the scroll vector and open Mirror Vectors  from the Vector editing 

toolbar. 

25 Select Over Model.  
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Welcome Plaque Design 

1 From the Bitmap Layers in the Project Tree, Import  the welcome bird.jpeg. 

 

2 Click on the New Vector Layers plus sign in the Project Tree next to Vectors to 

create a new Layer 

3 Do a slow double click on the new Vector Layer and Rename it to design 

4 Open Bitmap to Vector.   

5 Click on the Reduce Colours button. 

6 Change the Number of colours to 2 before selecting Apply. 

7 Click on the black from the palette to assign it as the primary colour.  

8 Select Create Vectors and close the panel. 

9 Hide the Bitmap Layers by clicking on the light bulb in the Project Tree. 
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10 Select the vectors as shown above open Transform Vectors.  

11 Increase the scale to 120% and press Apply (Do not close the form). 

12 The vectors have scaled relatively in both the X and Y direction. A scaling will be 

applied again but this time in the X direction only. This will result in the vectors 

‘stretching’ to fill the available space better.   

13 Unlock the option Maintain aspect ratio in the Scale and Size part of the form. 

14 Change the scale to mm and increase the New Width to 900mm (35.5”). 

 

 

 The Vectors have rescaled but in the X axis (horizontally) only. 
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15 Click on the New Vector Layers plus sign in the Project Tree next to Vectors to 

create a new Layer 

16 Do a slow double click on the new Vector Layer and Rename it to text 

 

17 Open Create Vector Text.  

18 Change to Font Showcard Gothic, Script Western, Size 90mm (3.5”) and Character 

Spacing of 160%. 

19 Type WELCOME 

20 Drag to position the text block as shown. 

 

 

 

 

21 Activate the border Vector Layer by clicking on it 

22 Select the outer main border vector and then Offset Vectors  from the Vector 

Creation toolbar. 

23 Offset a distance 20mm (0.75”) Outwards with Sharp corners. 
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The design is complete. 

 

 

Changing the Vector Layer colour is very good way to visually organize the design. If 

required, selecting the black circle  to the left of any Layer name allows you to assign 

a colour. 
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1 Click on the black colour swatch for the text Vector Layer 

2 Set Orange as the new layer colour and press OK 

3 Repeat for each Vector Layer, choosing your own colours. 

 

 

 

 

 

4 Select File > Save. Enter the name Welcome Plaque and then Save. 

5 Select File > Close Model. 
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4. 2D Machining 

Introduction 

This section covers the general layout found in most toolpath creation pages and the 

steps taken to generate a toolpath.  Profiling Wizard is used as the example. 

Functions 

   Profiling  Create a single line 2D toolpath that machines either along the 

vector or the outside or inside edge of a vector 

   2D Area Clearance  Create a 2D toolpath that machines/pockets out an area 

inside a vector using rest machining 

   V-Bit Carving  Create a 2.5D toolpath that engraves a V shape into a vector 

   Bevel Carving  Creates a 2.5D toolpath that engraves a prismatic/positive V 

shape into a vector 

   Drilling  Create a 2D rapid toolpath that plunges into vector areas 

   Delete Toolpath  Deletes the selected toolpath from the list 

   Tool Database  A database containing a broad range of pre-defined tools for 

machining 

   Material Setup  Specify the dimensions and origin of the material to be 

machined 

   Edit Toolpath  Change a previously generated toolpath 

   Save Toolpaths Converts the toolpaths to a machine specific format using a 

post processor while it’s being saved 
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   Simulate Toolpath  Mimics the toolpath machining into the material with 

video control to speed up or slow down 

   Delete Simulation  Deletes the current simulation, returning to the relief. 

   Reset Simulation  Resets the simulation block back to the flat defined sizes.  

 

Toolpaths: 

Clicking on Toolpaths in Project Tree will display all the Toolpath creation icons used to 

create new toolpaths. 

 

The Toolpaths that have been created are displayed in the Project Tree. Editing, 

Simulation, and management of all 2D and 3D toolpaths created happen here. 

 

The tools to create new toolpaths are available in the Toolpaths Panel below the Project 

tree. 

 

Also when you click on Toolpaths in the Project Tree, all the toolpaths that have been 

created are listed in the tree.  The toolpaths are given a name depending on the type of 

toolpath and the tool used or using the name manually typed in when calculating it.  

You can control whether the toolpath is shown in the 2D and 3D Views.  Simply turn on 

or off the light bulb icon to hide and show the toolpath. 

All toolpaths can be edited using the original creation page for that specific toolpath by 

double clicking the toolpath name in the list. 
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Toolpath tree parameters look like this: 

 

 

The Toolpath Operations section contains functions that are general to all toolpaths; 

such as save, delete, copy and merge existing toolpaths. 

 

The 2D Toolpath section contains all 2D and 2.5D toolpaths.  These toolpaths must all 

be generated within a vector boundary and typically to a specific depth (completely 

ignoring the relief). 

 

The 3D Toolpaths section contains all 3D toolpaths.  These toolpaths are generated 

around the contour of a relief. 
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To simulate a toolpath, simply click on the desired toolpath in the Project Tree and 

select the Simulate Toolpath icon. If Simulate Control is chosen, the Panel will pop up 

giving you simulation controls. 

      

If you click on a toolpath you get the Parameters Panel below the tree. The parameters 

panel displays information on the selected toolpath and allows you to change certain 

parameters without having to re-calculate the toolpath.  

 

 

 

Example 4-1 

Follow along with the teacher to complete the Example. 

 

Tool Database: 

The Tool Database is split into two main groups, Metric and Inch.  Inside the main 

section, there are material sections such as Steel, Wood or Plastic and HDU.  Inside the 

material section, you will typically find the same sections with the same tools, Roughing 

and 2D Finishing contain end mills, 3D Finishing contain ball nose tools, and V-Carving 

contain V-bit tools.  Even though similar tools are found in each section, they all have 

different feeds and speeds, depending on the type of material.  This is set up for 

general use; you can create your own sections and tools according to the materials and 

tools you use in your shop.  
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Save Toolpaths: 

The Save Toolpath function will save toolpaths created in ArtCAM to a language your 

machine will understand.  The toolpath in the right hand section is the toolpath you are 

saving.  The toolpaths in the left hand sections are all other toolpaths you have created.  

If you don’t have a tool changer, you can only save one toolpath at a time, if you do 

have a tool changer, you can bring all your toolpaths to the right side by using the 

arrows in the middle of the screen.  Once you are ready to save, look in the pull down 

menu ‘Machine output file is formatted for’, to find your CNC router.  Click the Save 

button and it will save the toolpath in NC code specific to your machine. 

 

 

 

 

 

Example 4-2 

Follow along with the teacher to complete the Example. 

 

2D Toolpaths: 

All 2D toolpaths must be calculated within a vector area.  If one vector is selected, it 

will machine within that vector.  If two vectors are selected (one vector inside another), 

it will machine the area between the two. 

Carving, V-Bit and Bevel: 

The depth of the V-Bit and height of bevel are dependent on two factors, the width of 

the vector and angle of the tool.  The wider the vector, the deeper it will machine.  Also 

the smaller the angle of v-bit tool the deeper it will machine. 
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Summary Tutorial: Saw Mill 

Complete this tutorial either using the Summary steps or the full instructions on the 

next page. 

 

1 New Model – Width=635 mm (25”), Height=230 mm (9”) 

2 Import Sawmill.eps 

3 F9 (centre in page) 

4 Transform Vectors – Uncheck Link, Width=610mm (24”), Height=200mm (8”) 

5 Ungroup vectors 

6 Group text 

 

Machining 

1 Area Clearance – between text and inside border 

 Finish Depth=0.3” (8mm) 

 Tools: 

 12mm end mill (raster strategy) (½”) 

 6mm end mill (offset strategy) (¼”) 

 1.5mm end mill (offset strategy) (1/16”) 

2 Material – Thickness=12mm (0.5”), Material Z Zero=top, Top Offset=0 

 Calculate and Close 

3 Simulate 

 

4 Bevel Carving – Sawmill text 

 Finish Depth=7mm (0.25”) 

 Tool=V-Bit 32mm, 130º (V-Bit 1.25”, 130º) 

 Calculate and Close 

5 Simulate 

 

6 Text Tool – “Reception” – Arial, Size=25mm (1”), Spacing=20% 

7 Center Horizontally (select text 1st, then border) 

8 Up or down arrows to center vertically 

9 V-Bit Carving – Reception text 

 Carving Tool=V-Bit 32mm, 90º (V-Bit 1.25”, 90º) 

 Calculate and Close 

10 Simulate 
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11 Drilling – 2 circles 

 Finish Depth=12mm (0.5”) 

 Tool=12mm end mill (½”) 

 Drill Center of = All Selected Vectors 

 Calculate and Close 

12 Simulate 

 

13 Profiling – outside border 

 Profile = Outside 

 Finish Depth=12mm (0.5”) 

 Tool=6mm end mill (¼”) 

 Leads – Circular Arc, Distance=12mm (0.5”), Radius=12mm (0.5”) 

 Bridges - Constant number=4, Bridge Length=12mm (0.5”), Bridge 

Thickness=5mm (0.125”) 

 Edit Bridges - Move, delete, add bridges 

 Calculate and Close 

 

14 Simulate 

15 Select the Simulation branch in the Project Tree 

16 In the Rendering section below,  and choose Light Oak (H) as the Material to see 

what the toolpath will look like once cut into the material 
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Tutorial: Saw Mill 

Introduction 

This demonstration shows some of the 2D and 2.5D machining features available within 

ArtCAM Pro.  You will use several different types of machining toolpaths; Area 

Clearance, Bevel Carving, V-Bit Carving, Drilling, and a Profile pass with Bridges.  

Saw Mill Tutorial 

1 Click New Model on the Getting Started page 

 The Size for New Model dialog box appears: 

 

 

This tutorial is based in the default ArtCAM 2012 function layout. If you have 

customised your layout and wish to return to the default, from the Window pull down 

menu choose Reset Layout and then click on Standard 

 

2 Enter in the following values: 

 Units = MM (or inch) 

 Width (X) = 635 mm (25”) 

 Height (Y) = 230 mm (9”) 

 Origin = lower left corner 

3 Click the OK button to accept 

The vectors for this project have already been created.  We will import the finished 

vector artwork. 

 

4 In the Project Tree, Right click on Vectors and select Import… 

5 The Load Vector Layer dialog box appears: 

 

 

6 Select the file Sawmill.eps, and click the Open button 

7 Switch to the 2D View 

The pre-designed vectors are imported and placed on the white model area. 
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The vectors should look like this: 

 

 

8 Press the F9 key on the keyboard. This is the shortcut for the Centre in Page function 

 

The vectors move into the centre of the model as shown: 

 

Now we will make the vectors bigger, so that they fill the model.   

 

9 Ensure that the vectors are selected, and click the Transform function  in the 
View Tools Toolbar 
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The Transform panel appears in the Tool Settings panel: 

 

 

10 At the top in the Scale and Size area, select mm (inch) for scale and the padlock icon 

to remove the aspect ratio (link) for the Width and Height. 

 

11 Change the New Width to 610mm (24”) and the New Height to 200mm (8”) 

12 Select Apply to make the changes 

 

The 2D view looks like this: 
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Notice when the vectors are selected, they are purple and they are selected all at once, 

this means they are grouped.  When a set of vectors are imported into ArtCAM, they 

come in as a grouped entity.  For machining purposes, we want to treat the vectors 

separately. 

13 Ensure the grouped vectors are still selected and click the Ungroup function  in 

the Vector Editing Toolbar  

 

We are now ready to create the toolpaths. 

 

Machining 

Area Clearance Toolpath 

We will create some toolpaths to clear out the background material around the letters.  

Since the letters will be used in a few different toolpaths as machining boundaries, we 

will first group the text together. 

 

1 Using the Left mouse button, drag a box around the letters (text) to select them 

 

The selected text should look like this: 

 

2 Click the Group function  in the Vector Editing Toolbar 

3 Now (make sure the text is still selected) hold down the Shift key for a multiple 

selection and select the vector border surrounding the letters only 

 

The selected vectors should look like this:  
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The Area Clearance toolpath can now be generated. 

 

4 On the Project panel, click on Toolpaths to show the toolpath creation icons  

5 Click on the Area Clearance toolpath function  located in the lower half of the 

panel 

 

The 2D Area Clearance panel automatically opens: 

 

6 Enter a Finish Depth of 8mm (0.3”) and a Tolerance of 0.02mm (0.001”) 

7 In the Machine Safe Z section, click the pull down arrow to display the hidden values 

8 Change the Safe Z and Home Position Z to 10mm (0.5”) 

 

Now we can select the tools to be used.  Area Clearance allows several tools to be 

selected for this strategy, and will machine first with the largest tool, then the next 

sized tool will be used only to machine areas left un-machined by the previous tool, and 

so on.  

 

9 Click the Add button in the Tools List section 

10 Select the End Mill 12mm (½ Inch) from the Wood or Plastic > Roughing and 2D 

Finishing section of the database 
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The tool appears in the Tool List section: 

 

 

11 Repeat this procedure to select the End Mill 6mm (¼ Inch) and the End Mill 1.5mm 

(1/16 Inch) 

 

There should now be three tools listed.  As each one is selected, the options associated 

with that tool are shown below the Tools List box. 

 

12 Select the End Mill 6mm (¼ Inch) in the Tool List box 

13 Change the Tool Clearance Strategy from Raster to Offset as shown: 

  

 

14 Repeat this for the End Mill 1.5mm (1/16 Inch) 

15 Click the Setup… button to define the Material 
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16 Ensure that the Material Z Zero is set to Top of Block, and the Thickness is 12mm 

(0.5”) 

17 OK to accept 

18 Click the Calculate Now button to generate the toolpaths 

 

The 2D toolpath preview appears in the 2D view. 

 

19 Click on the X to close the toolpath and panel  

20  Click on the 3D View Tab found in the top left corner to switch to the 3D view 

 

 

The toolpaths look like this: 
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The Toolpath Manager looks like this: 

 

 

 

21 Click on the End Mill 12mm (½ Inch) toolpath  to select it 

22 Click on Simulate Control Bar  

23 Play through the simulation until finished 
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The simulation in the 3D view looks like this: 

 

   Note that the 12 mm tool is used to machine as much material as possible 

without violating the letters. 

 

24 Select the End Mill 6mm (¼ Inch) toolpath in the Project Tree 

25 Right click and select Simulate 

 

The 6 mm tool is used only in areas that can be safely machined without violating the 

vectors that the 12 mm tool could not fit into. This is much more efficient than re-

machining the whole part. 

 

The Simulation looks like this: 

 

The simulation is a mimic of the actual piece after each toolpath has been machined.  

The simulation of 12 mm end mill was already done.  The simulation for the 6 mm tool 

removes the material from the previous simulation. 
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26 Select the End Mill 1.5mm (1/16 Inch) toolpath in the Project Tree 

27 Right click and select Simulate 

 

The 1.5 mm tool now only cuts areas the 6 mm tool could not fit into. This gives nice 

tight corners without having to cut the whole part with the 1.5 mm tool. 

 

 

Bevel Toolpath 

 

Now we will generate a Bevel toolpath to create positive prismatic letters. 

1 Click on the 2D View Tab  

2 Click the background area to de-select the vectors 

3 Select the grouped vector letters only as shown:  

 

 

4 Select Toolpaths from the Project Tree to view all the toolpath 

5 Click the Bevel Carving toolpath function  in the Toolpaths Panel 

The 3D Bevel Carving panel appears automatically: 
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6 Enter a Finish Depth of 7 mm (0.25”) 

 

   We are not using a wall height, as the background is already machined and we 

do not need to cut the letters out, so we will leave it set to 0.   

 

7 Now to define the Carving Tool, click the Select... button in the Carving Tool section 

8 The Tool Database appears, select the V-Bit 32mm 130 degree (V-Bit 1.25 Inch 130º) 

from the Wood or Plastic > V-Carving section and click the Select button 

 

The V-bit tool should appear on the page. 

Since we are not creating a Wall Height, we will not select a Profiling Tool.  The Profiling 

Tool would be used to cut the profile of the vector leaving a straight edge. 

 

9 Click the Calculate Now button to generate the toolpath 

 

ArtCAM calculates the centrelines of the vectors and then generates the toolpath. 

10 Click on the X to close the toolpath and panel  
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The Preview Vectors appear in the 2D view, and look like this: 

 
 

11 Click on the 3D View Tab  

 

 

The Bevel Toolpath looks like this: 

 

12 Right click on the toolpath and select Simulate Toolpath 

 

The Simulation looks like this: 
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V-Bit Carving 

In this section, we will engrave some text.  First we need to create the text. 

 

1 Click on the 2D View Tab to go back to the 2D view 

2 Click the Create Vector Text button  in the View Tools Toolbar 

 

The Text Tool function appears in the Tool Settings Panel: 

 

 

3 Set the Style of text to be Bold, Arial, with a Size of 25mm (1”) and Character 

Spacing at 20, as shown above: 

4 Now click the mouse button in the 2D View and type the text Reception 

 

 

5 Right click to finish and exit text creation 
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We need to make sure that the text is centred in the sign. 

6 Select the text, if not already selected, and then Shift-select the outer profile as 

shown.  (The text MUST be selected first.)  

 

 

7 Click the Centre Horizontally button  on the Vector Editing Toolbar        

8 Click anywhere in the 2D View to de-select the vectors 

9 Then select the vector text only  

10 Now use the Up or Down arrow cursor keys on the keyboard to move the letters 

approximately into position as shown 

 

The finished Reception text looks like this: 

 

 

We now apply a toolpath to the text using V-Bit carving. 

 

11 Ensure only the Reception text is still selected 
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12 Click the V-Bit Carving toolpath  on the Toolpaths panel 

 

The V-Bit Carving panel appears automatically. 

 

13 Select the Click to Select... to select the Carving Tool 

14 Select the V-Bit 32mm 90 degree (1.25 Inch, 90º) tool from the list, and click the 

Select button to select it 

15 Next click the Calculate Now button to calculate the Toolpath 

 

ArtCAM automatically generates the centrelines of the vectors and calculates the 

toolpath. The Preview Vectors appear in the 2D View and look like this: 

 

 

16 Click on the X to close the toolpath and panel  

17 Click on the 3D View Tab 

  

The toolpath looks like this: 

 

 

18 Right click on the V-Bit Carving Toolpath in the Project Tree and select Simulate 
Toolpath 

 

The Simulation looks like this: 

 



              
 

        4. 2D Machining            

 

                                                                                                                                      
                                                                                                              

 ArtCAM 2017  

4.24                                                                                                                 © Copyright 2016 Autodesk, Inc. All rights reserved 

Drilling 

Now we can drill the holes needed to mount the sign to the wall. 

 

1 Click on the 2D View Tab                               

2 First, select both hole positions marked in the 2D View using the left mouse button 

as shown.  (Select one, and then Shift-select the other) 

 

 

 

3 Now click the Drilling toolpath function  on the Toolpaths panel    

 

The Drilling function appears automatically: 

 

4 The Finish Depth is 12mm (0.5”) to ensure the holes go all the way through the 

material 

5 Click the Select... button to select a Tool 

6 Select the End Mill 12mm (1/2 Inch) by double clicking it  

 

 Note as we stretched the vectors un-proportionally, the drill holes are no longer 

true circles so we will use the all vectors option instead of Circular Vectors.  

 

7 In the Drill Centre of... section of the Drilling Page, select the option All Selected 
Vectors 

8 Click the Calculate Now button to generate the toolpath  
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The Preview Vectors look like this: 

 

9 Click on the X to close the toolpath and panel  

10 Click on the 3D View Tab  

The Drilling Toolpath looks like this: 

 

11 Right click on the Drilling Toolpath in the Project Tree and select Simulate Toolpath  

 

The simulation looks like this: 
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Profile Toolpath & Bridges 

 

We are now ready to cut out the sign by profiling around the outermost vector. 

 

1 Click on the 2D View Tab  

2 Select the outermost vector in the 2D View  as shown 

 

 

3 Select the 2D Profiling toolpath function  on the Toolpaths panel               

 

The Profiling function appears automatically: 
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4 Change the profile option to Outside 

5 The Finish Depth is 12mm (0.5”)  

6 Click the Click to Select... button to select the Profiling Tool 

7 Double click the End Mill 6mm (¼ Inch) to select it 

8 Change the Stepdown to 12mm (0.5”) by using the pull arrow to access the tool 

parameters 

9 Check the option Add Lead In/Out Moves in the Profiling Panel as shown  

 

 

 

 

The Panel is expanded to show the options for Leads: 

 

 

10 Select the option Circular Arc, and enter a Distance of 12mm (0.5”) and a Radius of 

12mm (0.5”) 

11 Check the option Add Bridges. 
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The panel is expanded to show the options for the Bridges: 

 

 

 

12 In the Constant Number section, enter 4. 

13 Enter a Bridge Length of 12mm (0.5”) and a Bridge Thickness of 5mm    (0.125”). 

14 Check the 3D Bridges option to create a 3D bridge. 

 

 This will leave four bridges or 'tabs' around the profile, a length of 12 mm, and Z 

height (Thickness) of 1 mm.  These will help to keep the sign in place while 

cutting it out of the material. 

 

15 Click the Add button to add the Bridges to the Toolpath. 

 

 

 

We will now move the bridges to more sensible positions which will be easier to remove 

the sign. 

 

16 Select Edit Bridges.  
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17 Move the mouse over the centre of the left bridge, (Zoom in if necessary using the 

wheel on the mouse). 

 

 

 

18 Hold the Left mouse button down, and drag the Bridge to a more sensible position 

as shown below. 

 

 

19 Now move the other bridges in the same way so that they are in positions as shown 

below. 

 

 

20 Zoom into the top-left bridge using the wheel on the mouse. 

21 You can remove the bridge by clicking on the centre of the bridge and pressing d. 
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22 Now add the Bridge back in by clicking the Profile Toolpath. 

23 Move the cursor over one end of the Bridge, and using the Left mouse button, drag 

the end to extend the Bridge as shown below, (do this for the remaining bridges). 

 

 

 

24 Click Calculate Now to generate the Toolpath 

 

We can now simulate the Profile Toolpath. 

 

25 Right click on the Toolpath in the Project Tree and select Simulate Toolpath  

 

The Simulation looks like this: 

 

 

26 Select the Simulation branch in the Project Tree 

27 In the Rendering section below choose Light Oak (H) as the Material to see what the 

toolpath will look like once cut into the material 

 

28 Zoom in to view one of the bridges as shown:  
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This tutorial is complete. 
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5. Relief Creation 

Introduction 

 

This example shows how to create and work with basic relief shapes. 

 

Functions 

   Shape Editor  Emboss a basic 3D relief from a vector or image 

   Preview Relief Layer  interactive golden greyscale representing active relief 

   Reset Relief  Reset all heights in relief back to zero 

 Draw Zero Plane  Toggle switch to show and hide the zero plane in 3D view 

 Origin  A toggle switch to show and hide the origin in the 3D view 

   Paste Relief From A File  Load a previously saved relief from disk (.rlf) 

   Save Relief  Save a relief to disk (.rlf) 

   Relief Clipart Library  Customisable library installed with over 400 3D reliefs 

   Extrude  Extrude a vector cross section(s) along drive curve to create a relief 

   Two Rail Sweep  Sweep a vector cross section(s) between two drive rails to 

create a relief 

   Create Vector Boundary  Automatically creates a vector around the outside 

edge the relief 
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   Display Material  show the shaded material (default gold) in 3D view 

   Display Bitmap  show colours from 2D view on 3D view 

   Toggle Vector Visibility  Hide and show vectors in the 3D View 

 

Note, some functions are grouped together in Toolset shown by the small arrow the in 

lower right corner of the function.  Hold the mouse down on the icon and continue to 

hold to pull out the menu. 

 

Relief Creation Information 

 

Reliefs are solid 3D models.  All reliefs are created (or pushed up or down) from the 

zero plane. 

 

 

Example 5-1 

Follow along with the teacher to complete the Example. 
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Shape Editor Basics: 

Always switch to the 3D View before clicking the Add button.  This allows you to see the 

change when it happens and makes it easier to spot unsatisfactory results. 
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Shape Editor Angle: 

The angle is measured from the horizontal plane. An angle of 0 degrees will always 

produce a plane. A positive angle produces a convex profile and a negative angle 

produces a concave profile. 

 

 

This field is greyed out when a Plane Profile is selected. 

The picture below shows two regions with the same Profile, Start Height, Region Height 

(No Limit) and Scale. The left one is generated with an Angle of 45 degrees, the other 

with an Angle of 85 degrees. 

 

 

The picture below shows two regions with the same Profile, Start Height, Limit Height 

and Scale. The left one is generated with an Angle of -85 degrees, the other with an 

Angle of +85 degrees. This specifies whether a region will be convex (raised) or 

concave (recessed). 
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Shape Editor Start Height: 

This controls the starting height for the region. The relief for the region is calculated 

and then the base height value is added to the height calculated for each pixel in the 

region. If the profile type is Plane, setting this field controls the height of the plane. 

 

 

 

Shape Editor Height: 

The default setting is No Limit. In this case the profile is allowed to grow to the height 

that it will normally reach, depending upon the parameters that have been set. 

 

Limit To Height sets a limit which the profile may not exceed. The profile will "plateau 

out" at the specified height and will have a flat top, if the natural height is higher than 

the height limit that is set. Parts of the relief that do not reach the height limit will be 

unaffected. 

 

 

Scale To Height means that a scaling factor will be applied to the natural height so that 

the profile will reach the specified height. The height that is set may also be smaller 

than the natural height. Note that this does not produce the same effect as Limit To 

Height. Scale To Height will not alter the shape of the profile (no flat top), it simply 

scales the shape in the Z-axis. 
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Relief Operations: 

Add Relief  

 

 

Subtract Relief 

 

 

Merge High Relief 
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Summary Tutorial: Anchor Relief 

 

1 Open Model anchor.art 

2 Shape Editor – large top bar 

 Flat Plane with Start Height of 0.5 mm (0.02”) – Add & Apply 

3 Hide Zero Plane 

 

4 Shape Editor – 2 inner top bar vectors 

 Round at 45º, with Start Height of 0 – Add & Apply 

5 Shape Editor - main anchor vector 

 Square at 65º, with Limit to Height 0.75mm (0.03”) - Merge High & Apply 

6 Shape Editor – two hook vectors 

 Round at 30º, with Start Height of 0.75mm (0.03”) - Merge High & Apply 

7 Shape Editor -  two Circle vectors 

 Round at 65º, with Start Height of 0.5 mm (0.02”) - Merge High, Apply & Cancel 

8 Toggle Vector Visibility off  

 

The Vectors are hidden, and the final result can be seen. 
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Tutorial: Anchor Relief 

This example shows how to create and work with basic relief shapes. 

 

1 Click on the Open Model function in the Start Panel to display the Open dialog box 

2 Open the model anchor.art 

 

The vectors are displayed in the 2D view and 3D View. 

 

This tutorial is based in the default ArtCAM function layout. If you have customised your 
layout and wish to return to the default, from the Window pull down menu choose Reset 
Layout>Standard 

3 Change the 3D View from Top View to Isometric View  

 

The vectors are displayed on the 3D View. 
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4 Double left mouse click on the vector shown below to open the Shape Editor form 

 

 

5 Select a Plane shape with a Start Height of 0.5 mm (0.02”) 

 

For a Plane, The Start Height indicates the very top Z level. 
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6 Set the Combine Mode to Add 

7 Click the Apply button to generate the shape 

8 Click the Cancel button 

9 From the 3D view toolbar, click on Draw Zero Plane  to hide the Z zero plane 

 

The bar is produced as shown. If you place the mouse on the Relief, the Z height at 

that point 0.5mm (0.02”) will be displayed in the information box at the lower right 

of the graphics area. 

 

 

10 De-select the bar vector by clicking in empty space 

11 Hold down the shift key and select the two inner vectors as shown 

 

A Relief will now be generated inside the two selected vectors.  
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12 Press F12 on the keyboard to open the Shape Editor form 

 

13 Select a Round shape with an Angle of 45 degrees and No Limit with regard to overall 

height 

14 Enter a Start Height value of 0 (0”) 

15 Click the Apply Button 

16 Click the Cancel button 
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A Dome shape of 45 degrees has been created within the selected vectors. The final 

height of the dome was dictated by the defined angle (as No limit was selected) 

 By Selecting Add, the new relief ‘added’ to the initial bar relief below.  

 

The main body of the Anchor will now be created and merged into the current Relief. 

 

17 Select the main anchor vector as shown highlighted 
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18 Press F12 on the keyboard to open the Shape Editor form 

 

 

19 Select a Square shape with an Angle of 65 degrees 

20 Select Limit to Height and Enter a value of 0.75mm (0.03”) 

21 Click the Merge High box and Apply 

22 Click the Cancel button 
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The main anchor shape is created and merged with the bar relief. 

   This shape was produced from the vectors extruding as a triangular shape of 65 

degrees. As it reached a height of 0.65mm, it ‘levelled off’. 

 

23 Shift Select the two hook vectors as shown 
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24 Press F12 on the keyboard to open the Shape Editor form 

 

25 Select a Round shape with an Angle of 30 degrees 

26 Enter a Start Height value of 0.75mm (0.03”) 

27 Click the Merge High box and Apply 

28 Click the Cancel button 
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The ‘hook shapes’ have been created and merged with the main body. 

 The Start Height provided a ‘platform’ of 0.75mm before a dome 

shape of 30 degrees was applied. 

 

29 Shift Select the two Circle vectors as shown 
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30 Press F12 on the keyboard to open the Shape Editor form 

 

31 Select a Round shape with an Angle of 65 degrees.  

32 Enter a Start Height value of 0.5 mm (0.02”) 

33 Click on Merge High box and Apply 

34 Click the Cancel button 
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35 From the 3D View toolbar, click on Toggle Vector Visibility  

 

 

 

The Vectors are hidden, and the final result can be seen clearly. 

 

36 Save the ArtCAM Model 
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Tutorial: Bitmap Motif 

Introduction 

The following tutorials demonstrate the creation of a basic relief from bitmap colours. 

              

1 Open BitmapMotif.art 

2 Switch to 3D View 

3 Toggle on Display Bitmap icon from the 3D View toolbar  

 

4 Double click on the colour blue directly to open the Shape Editor 

 Choose a Round shape with an angle of 30 degrees 

 Enter in a Start Height of 1mm (0.05”) 

 Check Scale To Height and type in a Height of 3.5mm (0.15”) 

 Click Apply and Cancel 

5 Double click on the colour green to open the Shape Editor  

 Choose a Round shape with an angle of 30 degrees 

 Enter in a Start Height of 1.5mm (0.1”) 

 Click Apply and Cancel 
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6 Double click on the colour red to open the Shape Editor  

 Choose a Round shape with an angle of 40 degrees 

 Enter in a Start Height of 2mm (0.1”) 

 Check Limit To Height and type in a Height of 2mm (0.1”) 

 Click Apply and Cancel 

7 Select Display Material  to toggle back to the Relief (material) view. 

8 Select Smooth Relief  from the Relief Editing Toolbar  

 Apply 3 smoothing passes and close the form 

9 Toggle Zero plane  from the 3D view Toolbar to view the results. 
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Example 5-2 

Follow along with the teacher to complete the Example. 

 

Save and Load Relief: 

A .rlf file only contains the 3D relief (no vectors, colour, or bitmap).     

When a relief is saved, the origin is taken into consideration.  Therefore when it is 

loaded back in, it always returns to the same position from the origin. 

 

 

 

Example 5-3 

Follow along with the teacher to complete the Example. 

 

Extrude: 

Drive Curve  The curve that the cross-section follows. The tab or hash marks on the 

line show which side the cross-section will be created on. 

Cross-section  A cross-sectional shape that will become the relief.  The tabs or hash 

marks must always be on the inside of the curve, use the Invert curve in Z box to 

change it. 

 

Two Rail Sweep: 

When selecting vectors, you must first select the vector and then press the select 

button. 

 

Create Vector Boundary: 

Create an automatic vector outline around the Composite Relief. 
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6. Relief Editing 

Introduction 

 

This example shows how to use some of the relief editing tools. 

Functions 

   Set Model Size  Set the real physical size of the model 

   Smooth Relief  Apply smoothing filter to the whole relief or a specific area 

   Texture Relief  Apply 3D texture to the whole relief or a specific area 

   Scale Relief Height  Scale relief heights in Z 

   Smooth Sculpting  Interactive Sculpting tool to smooth areas of the relief 

   Smudge Sculpting  Interactive Sculpting tool to re-model relief like clay 

   Deposit Sculpting  Interactive Sculpting tool to add material to the relief 

   Carve Sculpting  Interactive Sculpting tool to remove material from the relief 

   Envelope Distortion  Select a floating blue relief clipart to copy, distort, and 

paste it along a curve 

 

 

 

 

 

 

 



              
 

        6. Reliefe Editing            

 

                                                                                                                                      
                                                                                                              

 ArtCAM 2017  

6.2                                                                                                                  © Copyright 2016 Autodesk, Inc. All rights reserved 

 

The following can be managed from the Relief Layers section. 

 Add a new Relief Layer to the model 

 Import a new Relief Layer from a file 

 Export the selected/highlighted Relief Layer 

 Duplicate the selected Relief Layer 

 Transfer the selected Relief layer to the opposite side (Back Relief Layer) 

 Create a new Bitmap Layer from the selected Relief Layer 

 Delete the selected Relief Layer from the model 

 Merge (combine) the visible layers to form a new Relief Layer 

 

 

 

 

Example 6-1 

Follow along with the teacher to complete the Example. 

 

Smooth Relief: 

Until you become familiar with the smooth relief function, it is best to only do one pass 

at a time, each pass can cause a large amount of detail to be lost. 

Sculpting: 

The Sculpting functions work with the relief as if it were a piece of clay allowing you to 

interactively alter it. 
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Example 6-2 

Follow along with the teacher to complete the Example. 

 

Texture Relief: 

When using From File, typically an .rlf is selected, a texture block that has already been 

created as a relief.  An image file can also be selected, in which case it creates the relief 

texture for the first time.  The downfall of this is most of the time a new texture must 

first be edited (smoothed and possibly inverted) before it can be used.  If you create it 

and put in on an existing relief all in one step, the texture cannot be edited by itself. 

 

 

 

Tutorial: Texture From Image 

Intro 

Quickly create 3D textures from a series of images. Use the clipart library to store the 

new textures. 

 

This document was created to coincide with the video. For more details on this tutorial, 

please watch the video. 

 

Stone Pattern Texture 

1 Open Model - stone_pattern.png 

 Width = 12” 

 

 

2 Select the stone_pattern Bitmap Layers in the Project Tree 
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3 Create Relief Layer (from bitmap layers)  

 New Height = 0.15” 

4 Smooth Relief  - 1 pass 

 

Next you are ready to save your new texture by into your clipart folder 

 

5 Open Relief Clipart Library  

 Chose to view the Custom Reliefs clipart folder 

 Using your left mouse button select in your project tree, stone pattern Relief 

Layer you have just created 

 And drag into the Relief Clipart Library 
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Tutorial: Relief Layer Badge  

 

1 Open Model Relief Layer Badge.art 

2 Expand the Front Relief Layers section of the Project Tree 

 

3 Hide all Relief Layers by clicking on the twin light bulb  next to the main branch 
Front Relief 

 

To better understand layers, use the light bulbs to hide and show different relief layers. 

This will help demonstrate how they interact together. Hide all the layers when finished 

 

4 In the Project Tree, click on the light bulb  to show the Laurel Relief Layer and the 
Flower3 Relief Layer  

5 Show the Base Relief Layer and note how it embosses the other reliefs 

6 Show the ArtCAM Relief Layer to finally display the text 

 

As demonstrated, a Relief Layer can be switched on/off as required by clicking the 

adjacent light bulb icon. Any Relief operations assigned to a Relief Layer that is 

switched off will be temporarily hidden from the model. 

 

 

7 Hide the Base Relief Layer to see the result 
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8 Toggle the Base layer back on but Hide the Flower3 Relief Layer 

9 Make the ArtCAM Relief Layer active by clicking on its name to highlight it. 

 

10 Select New Relief Layer  from the lower Project Panel. 

The new Relief Layer is created directly above the active Relief Layer. 

  

11 Select the new Relief layer and rename it to Lion from the lower Project Panel  

 

12 From the Relief pull down menu, chose Import, followed by Import to load in an 

existing relief  

 

13 Choose Lionhead.rlf from the ArtCAM data folder 

14 No changes are required so Click Paste on the Transform form 
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Relief Layers can be utilised to organise work, simplify adjustments, and easily 

experiment with different variations. 

 

15 Create another New Relief Layer and rename it to Banner. 

16 Open the Relief Clipart Library from the Relief creation toolbar  

 In the pull down list at the top, choose the Banners Library. 

 Click on Banner1 to select and import it 
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17 Use the Transform tools to resize and position it suitably or use the parameters 

suggested below. 

 Press F9 to centre in the model 

 In Scale and Size, enter a new Scale of 50% with all sizes linked then click Apply 

 In Origin position, Enter a value of 2 in Y and then Apply (note ArtCAM model is 

in imperial units)  

18 At the top of the Form, Click on More Options icon     

 For now, ignore the Paste Combine Mode but enter a value of 0.1 for Height (start 

height). 

 Select Paste. 

 

The banner appears to be sitting overlapped with the rest of shield. This can be 

changed by adjusting the Relief Layer Combine mode.  The Combine mode dictates how 

the Relief Layers interact with each other. Currently all the Relief Layers are on the Add 

Combine mode. If the problem layer, in this case, the new banner layer is changed 

from Add to Merge High, it will blend in with the relief of the design. 

 

19 Make sure the Banner Relief layer is active 

20 In the lower parameters section on the Project panel, change the Combine mode 
from Add to Merge High 
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The banner now blends in with all the other Relief Layers.  

The Relief layers are effective from top to bottom. The Combine mode of the top Relief 

Layer affects everything below it. The Combine mode of the bottom Relief layer affects 

nothing. 
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Summary Tutorial: Grape Vine 

Complete this tutorial either using the Summary steps or the full instructions on the 

next page. 

 

1 Open Grape-Vine.art 

2 Toggle Vector Visibility on 

 

3 Vector Layer = Leaf and Construction 

4 Relief Layer = 3D Leaf 

5 Extrude 

 Drive Curve = diagonal line – use as a centreline 

 Cross Section = bottom curved profile –  invert curve in Z 

 Z Modulation = 2nd from bottom curve 

 Apply, Cancel 

 

 

6 Select leaf vector - Zero Outside Vector 

7 Shape Editor – Select leaf vector 

 Add (Round -5º, Start Height=1mm (.05”) 

 Apply 

8 Select leaf veins 

 Add (Round -25º, Start Height =-0.5 mm (-0.02”)) 

 Apply, Cancel 

 

9 Vector Layer = Vines 

10 Relief Layer = 3D Vine 

11 Shape Editor – Merge and Apply each vine 

12 Greyscale, primary colour = yellow 
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13 Sculpting – smooth crease where branches meet main vine 

 Smooth, Mask Material Safety Plane 0.25 mm (0.01”) 

 

14 Vector Layer = Grapes 

15 Relief Layer = 3D Grapes 

16 Shape Editor – Merge and Apply each set of grapes 

 

 

This tutorial is complete! 
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Tutorial: Grape Vine 

Introduction Scenario 

A customer has asked us to reproduce an existing moulding. He has indicated to us that 

it doesn’t need to be an exact duplicate, but if the end results produced in ArtCAM were 

similar to the original, then that would be fine. 

 

 

Getting the Design into ArtCAM 

There are several different ways that an ArtCAM user could go about getting the design 

vectors into the software. 

 

The first method, the designer would visually inspect the piece of moulding and with 

part in hand would build the vectors in ArtCAM by eye. This is actually the way that the 

vectors we will be using have been created. 

 

A second method to get this data into ArtCAM could be, to take a digital photograph of 

the moulding and use it as a template. The photo could be opened in ArtCAM and the 

user could trace the necessary outline vectors. This method may be a bit easier for 

someone who may not be very artistic. Using a digital photo would give the user the 

ability to follow the outlines of the picture and basically trace it. 

 

The third possibility could be to use the plastic transparency sheet on the Wacom 

Pressure sensitive tablet and manually trace the outline of a printed photograph. This 

option is similar to the second method but may apply more to someone who may not 

have the image in digital format. If it was a small 5” X 7” photo it could be blown up in 

size before it was used for tracing, this is of course providing the size of the photo stays 

within the limits of the Wacom tablet’s transparency envelope. 

 

Analysing the Design Vectors of the Grapevine 

If you look and see how the designer of this file has set up the design vectors you 

should notice a few things. 
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The vectors for each modelling section are on separate layers, making it much easier to 

work with. 

 

You can see that there are several separate vector entities that represent the different 

branches of this vine.  These parts of the vine have been separated out so that there is 

a certain effect achieved when the vine is built.  If these areas were all combined into 

one main branch then the results of building the vine shape would not look natural or 

organic.  What would end up happening is the large common area where the main vine 

and the smaller vine meet up would have a very balloon like and bubbly appearance.  

The only way that a user would know this information would be from trial and error 

and/or from experience.  Having the small branches of this vine set up the way they are 

is going to give us the most natural looking effects possible with the least amount of 

relief modelling effort. ArtCAM contains useful tools that we can use to go in and alter 

these areas to look more natural after we have built them into 3D. 

 

If you select the circular vectors representing the grapes, you will notice that they have 

not all been grouped together as one entity.  Random diameter circles within the bunch 

have been grouped together in order to give the relief of the grapes a varying effect.  

This varying effect for the grapes is achieved by the difference in the diameter of the 

various circular vectors.  

The way it has been set up is that the different groups have been assigned unique 

characteristics for relief modelling and since the circles have varying diameters they will 

individually reach unique heights.  The way that ArtCAM works is, when using the 

Shape Editor to build reliefs the software associates width with height, therefore the 

wider something is the higher that it is going to have to be in 3D space so that it looks 

proportional. 

 

The leaf has two design vectors showing the shape, there are other vectors on another 

layer that will be used to achieve an underlying sweep. 

 

One last detail to pay attention to in this design is the resolution. Resolution is a very 

important factor of an ArtCAM job.  The resolution is set at 1991 X 663 pixels; normally 

the rule of thumb (depending on job sizes and relief modelling technique) is that the 

shortest side of the model should contain approximately 1000 pixels.  Having said this 

you can see that the shortest side of this job only contains 663 pixels.  The reason for 

this is that the entire piece is going to be modelled using vector modelling.  When you 

are doing vector modelling it is possible to work with a resolution that is approximately 

1/3 less than what you would normally use if you were colour modelling.  The 1000 

pixel rule outline above is for colour modelling so that is why you are seeing a lower 

resolution then normally recommended. 
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Strategy for Building the Grapevine 

As with most projects it is important that before you begin to work that you think about 

how you are going to get to the final result. The same rules apply to ArtCAM, before we 

start to build our relief, we should take a few minutes to look at it and think about the 

best way to build our design into a 3D relief. 

 

As in many cases with ArtCAM, when you are going to be building a design that 

contains several parts or pieces, it is best to try and isolate the smaller parts and build 

these in separate relief layers. 

 

For the Grapevine the plan is going to be as follows: 

 Create three different relief layers for Grape Leaf, Main Vine and 

Grapes and construct them in individual relief layer. 

 Build the leaf is several steps.  Since the Shape Editor is not going to 

give us enough control over how the shape is built, the designer has 

decided to utilize one of the more user definable relief modelling tools; 

Extrude.  

 The extrusion function will be used to build the underlying shape of the 

leaf. 

 Build up the vine shape using the main vine vector as well as the 

branch vectors.  

 Since the piece needs to look as natural and organic as possible we will 

have to do some sculpting on certain areas of the relief.  

 The third relief that is going to be built will be the grapes.  The grapes 

should be quite straightforward and easy to build since we will just use 

the Shape Editor to build the shapes.  

 Once building the individual relief is done all the layers will be made 

visible. 
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Building the Grapevine 

1 Open the file Grape-Vine.art  

 

This tutorial is based in the default ArtCAM function layout. If you have customised your 

layout and wish to return to the standard, from the Window pull down menu choose 

Reset Layout. 

 

2 Toggle Vector Visibility to on to show vectors in the 3D View 

 

Grape Leaf 

 

 

 

1 From the Project Tree, show the Leaf and Construction Vector Layers, hide all other 

Vector Layers 

2 Make 3D Leaf the active Relief Layer 

 

The Leaf layer contains the vector representing the size and shape of the leaf. 

The Construction layer has additional vectors used to assist us in building the 

underlining relief. 
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3 Open the Extrude function from the flyout toolbar located on the Relief Creation 

toolbar 

4 In the model area pick the straight vector that runs through the leaf for the drive 
curve and click Select button in the panel next to Drive curve 

5 Check the Use as centreline box 

 

6 Pick the vector that represents the profile (Cross-Section) for this extrusion, click 
the Select button next to Start Profile 

7 Check the Invert curve in Z box to make sure that the hash marks are on the inside 

of this vector shape 

8 Pick the vector that represents the Z modulation  and click the Select button next to 
Z Modulation 

9 Make sure that Add is the option that is selected and then click the Apply button to 

build the underlying shape of the Grape Leaf 

10 Close the Extrude panel 

 

Notice that the underlying shape for this leaf that has been extruded is larger than the 

actual leaf itself. This is a pretty common technique used for relief modelling in ArtCAM 

where the underlying shape is created much larger than needed and then the required 

area gets trimmed out. 

 

11 Select the vector outline of the leaf and press the Zero Outside Vector function 

 

This should trim out the shape of your leaf. 

 

12 With the leaf outline vector still selected, press F12 to open the Shape Editor 

13 Click Add in the Shape Editor window then Close 

 Dome, Angle=-5º, Start Height=1mm (0.04”), Apply 

 

This will add the concave shape of -5º with a small start height to the leaf.  You will not 

see much of a change when the vector attributes are added to the existing relief.  The 

leaf will get a bit higher and it will also provide a bit more of a dish shape to the leaf.  

By doing this we are trying to add a more natural look. 

 

14 Select the vectors that represent the vein detail for the leaf 

15 Press F12 to open the Shape Editor 

 Add Dome, Angle= -25º, Start Height= -0.5 mm (-0.02”) , Apply 

16 In the Project Tree, click on the light bulb next to 3D Leaf to hide the 3D Leaf Relief 
Layer 
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Main Vine 

 

 

1 Make 3D Vines the active Relief Layer 

2 Show the Vines Vector Layer, hide all other Vector Layers 

3 Select the vine vectors one by one, open the Shape Editor with F12 and Add or 

Merge high. The values are already applied to the vector shape; 

 Main vine (Dome 68º, Start Height=1mm (0.05”), Add), Apply 

 1st and 2nd branch (Dome 83º, Start Height 1mm (0.04”), Merge High), Apply 

 3rd branch (Dome 70º, Start Height=1mm (0.04”), Merge High), Apply 

 4th branch (Dome 83º, Start Height=1mm (0.04”), Merge High), Apply 

 5th branch (Dome 70º, Start Height=1mm (0.04”), Merge High), Apply 

 

 

Observe the creases in the areas where the branches have been merged into the main 

vine.  Ideally, we want to smooth these areas in order to make the vine look more 

organic. 

 

4 Zoom into the first area where you can see the creases 

5 Activate the Smooth Sculpting tool  

6 In the Tool Setting Panel, set the following: 

 Radius = 25 

 Strength = 50 

 Smoothness = 100 

 In the Mask area, check the Material Safety Plane and enter in a value of .025mm 

(0.01”) 

 

By making adjustments to the Mask section of the Sculpting panel, we ensure that 

when we are smoothing the relief, the smooth tool will not affect the background (zero 

plane), causing a radius at the edge where the relief meets the zero plane.  

 

7 While using the Smooth tool, vary the diameter and strength of this tool accordingly 

to achieve the desired results 

8 Smooth the creases where the smaller branches attach to the larger branch 
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Basically we just want to get rid of the creases and make the vine look more natural.  

Individual results may vary.  

 

To zoom in & out you need to hold the Alt key down while using the mouse as you 

would in a regular 3D view, or use the icons at the top of the screen. 

 

9 Click on the light bulb next to 3D Vines to hide the 3D Vines Relief Layer 

 

 

 

Grapes 

 

 

1 Make 3D Grapes the active Relief Layer 

2 Show the Grapes Vector Layer, hide all other layers 

3 Select the different groups of circles that represent the grapes and use the Shape 

Editor to build these shapes and use Merge Highest. The values are already applied 

to the vector shape; 

 1st set (Dome 86º, Start Height= 3 mm (0.13”), Merge High), Apply 

 2nd set (Dome 80º, Start Height= 2 mm (0.11”), Merge High) , Apply 

 3rd set (Dome 89º, Start Height= 1 mm (0.06”), Merge High) , Apply 

 4th set (Dome 68º, Start Height= 2 mm (0.10”), Merge High) , Apply 

 

Use the Merge High option so that the grapes are blended into one another.  

 

It can be useful to use the preview Relief Layer function if working from the 2D view to 

track the progress of your relief in the 2D view. Doing this will display an interactive 

greyscale of the areas as they built.  
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Viewing Combined Reliefs 

Now that we have built all of the pieces for our finished part we can now bring them all 

together. 

 

 

4 Show all Relief Layers 

5 Toggle Vector Visibility to hide the vectors in the 3D View  

6 Save the finished ArtCAM files as Finished Grape Vine.art 

 

The design is now complete and ready for machining. 

 

For this project the grape vine relief has already been created and is now ready to be 

machined.  In a later tutorial you will generate three toolpaths in order to machine this 

part in an efficient manner.  The first toolpath will machine away the flat background.  

The second toolpath will rough out the area immediately surrounding the relief and the 

third creates a 3D toolpath to machine the shape of the vine and grapes. 
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Example 6-3 

Follow along with the teacher to complete the Example. 

 

Envelope Distortion: 

Envelope Distortion can be used with vectors or reliefs. The relief must be free float 

blue clipart. 

If you wish to distort an existing relief in the model, use the Cookie Cutter to convert it 

to blue clipart first. 
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7. 3D Machining 

Introduction 

 

This example shows how to generate 3D toolpaths. 

Functions 

   Machine Relief  Create a 3D toolpath that follows the contour of the 3D relief. 

The Machine Relief toolpath also allows for Z level roughing within the toolpath 

 

Example 7-1  

Follow along with the teacher to complete the Example. 

 

Z level Roughing: 

If any value is changed in the tool parameters, make sure to click the Apply button to 

update the Z Slices section. 

 

Toolpath Summary: 

The time scale factor is very important in regards to the machining time.  When ArtCAM 

calculates the time, it takes the length of the red toolpath lines times the feeds and 

speeds you entered.  It does not take into consideration that your machine slows down 

when it changes direction.  Each CNC router speeds up and slows down at a different 

rate.  The time scale factor makes up for this difference.   

For starters, set the time scale factor to 1 and make note of the value.  Then machine a 

few parts and compare them to the output the estimation given by ArtCAM and adjust 

the value accordingly. So if ArtCAM estimates 30 minutes with a Time Scale Factor of 1, 

but it actually takes 60 minutes to machine, the Time Scale Factor for that specific 

machine must be set to 2. 

You may need two time scale factors, one for 2D machining and one for 3D machining. 
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Material Setup for Reliefs 

 

In the pictures shown below, the Material for machining is 2 inches (50 mm) thick and 

the relief is 1.5 (40 mm) inches thick.   

The material Z Zero is set to the top, meaning the CNC machine will be zeroed from the 

top of the material. 

You have the choice of where to place the relief in the 2” (50 mm) material.  Currently 

the Top Offset is set to 0.1” (2 mm), meaning the relief will be dropped into the 

material 0.1” (2 mm).  During machining, the top 0.1” (2 mm) of material will be cut 

away, removing any imperfections.  The 1.5” relief is machined, leaving 0.4” (8 mm) of 

stock under the part. 

 

You can use the slider bar or type a specific value to position the relief within the 

material.  For example, if you do not want stock left under the part, change the Bottom 

Offset to 0. 
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Tutorial: Lizard machining 

 

Introduction 

For this project we will machine the finished lizard into a soft material such as HDU.  

The lizard will then be cut out of the material.  We will start by using a Machine Relief 

toolpath within a selected vector area so as to avoid machining the flat background 

which in this case we do not need.  The lizard will be then cut out of the material using 

a Profile toolpath.  We would like the finished lizard to have total height of 1.5”, but the 

lizard relief is currently 1.545”, so the lizard must first be scaled down in the Z prior to 

machining. 

 

Preparing the Lizard for Machining 

1 Open the file Lizard.art 

The relief must be scaled down in the Z only.   

2 Open Scale Relief Height  from the Relief Editing Toolbar 

 Scaling = Height 

 Mask = None 

 New Height to 35mm (1.5”)  

 Detail = None 

 Click the Apply button  

 

3 Create a New Vector Layer called Machining 

4 Hide the Default layer 

5 Toggle on Preview Relief in the 2D view  

 

For the 3D toolpath, we will machine within a vector boundary.  When generating a 

Machine Relief toolpath within a specific area, it is good practice to offset the vector 

outwards by a little more than the radius of the tool you will use to cut it.  The reason 

being, that during a Machine Relief toolpath, the center of the tool stops on the vector.  

Since the vector is right up against the relief, the tool cannot drop down to reach the 

bottom edge of the relief.  If we offset the machining vector by the radius of the tool, 

there will be enough room for the tool to reach down to the base of the relief.  However 

in the Machine Relief we can have ArtCAM create a machining vector for us containing 

the correct offset (radius of tool) for the required cutting tool. The Automatic 

Boundary option will automate this whole process.  
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Machining the Lizard 

1 Open the Machine Relief toolpath strategy  

 Select the Automatic Boundary function 

 Offset = 0 

 Finish Tool = 3mm ball nose (1/8 Inch ball nose) 

 Rough Tool = 6mm end mill (1/4 Inch end mill) 

 Stepdown = 13mm (0.5”) 
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2 … continue Machine Relief Toolpath: 

 Material 

 Thickness = 50mm (2”) 

 Material Z Zero= top 

 Bottom Offset = 8mm (0.3”) 

 

We are leaving 0.3” (8 mm) of stock material underneath the lizard, this will help 

strengthen the finished part. 

 

3 3D View 

4 Click the Calculate Now button 

5 Close 

6 Simulate Toolpaths  
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7 2D View 

8 Open the Create Vector Boundary tool  

 Create a vector boundary around the Composite Relief 

 

The vector we have just created follows along the outside edge of the lizard.  This 

vector will be used for the Profile cut out pass, the last toolpath we will create.  

When a Profile pass is created, you have the choice to run the tool on the inside or 

the outside of the vector.  In this case, we will choose the outside.  

 

9 Select the new boundary vector on the edge of the lizard 

10 Open the Profiling toolpath function  

 Finish Depth = 50mm (2”) 

 Tool =  3mm end mill (1/8 Inch) 

 Stepdown = 13mm (0.5”) 

11 Click the Calculate Now button 

12 Click the Close button 

13 3D View 

14 Choose the Profiling toolpath 

15 Simulate Toolpath  

 

 

 

The toolpaths are now ready to be sent to the router to be machined. 



 
 

8. Post Processing Toolpaths 

                           

 

      
ArtCAM 2017    

© Copyright 2016 Autodesk, Inc. All rights reserved           8.1 

8.  Post Processing 

Toolpaths 

Introduction 

 

The Toolpaths produced in ArtCAM must be translated into a different format as an 

exported file for a specific machine tool controller. The collective name for one of these 

files is NC data and the operation is called Post-Processing which is accessed via the 

Save Toolpaths option.  

 

 

1 Open a previously machined model. 8 - machine-ted_completed.art. 

2 Activate the Project panel if not already visible. 

 

 

 

3 Highlight Toolpaths from the List then Save Toolpaths  from the Toolpath 

Operations area in the lower Project panel. 
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When the Save Toolpaths form is opened all existing toolpaths are listed in the right 

hand window (as Toolpaths group was highlighted). Toolpaths are selected and 

transferred from one side to the other using the central Arrow buttons as highlighted 

above.                                                             

All the files in the right hand window (Toolpaths to save/post process) will be 

included for output into a single NC data file.  If the machine tool uses a manual tool 

changer then it will only be possible to include Toolpaths in the NC data file that share 

the same cutting tool.  

If the machine tool has an automatic tool changer then any combination of the 

available toolpaths can be include in the NC data file (as long as the selected machine 

supports it). 

Post Processing of Toolpaths for a Manual Tool Changer 

 

1 Shift select all Toolpaths apart from the first Machine Relief-End Mill 6mm 

Roughing. 

2 Click the Left arrow  to transfer into the Calculated toolpaths.  

 

 

3 Browse… to a suitable location (e.g C:\Temp)and enter File name as Em6-

Rough-ted.  

4 Select Open on the Browse window to return to the Save Toolpaths window. 

5 From Machine file format select Axyz_Arc_MM(*.nc). 
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 This machine does not support an automatic tool changer hence only Toolpaths 

that use the same tool can be included in the ncdata output file. 

 

6 Select Save to post process the Toolpath. 

7 Select the left arrow  to transfer the toolpath back to the left window.  

8 Select the toolpath Machine Relief-Ball nose 3mm finishing and then the right 

arrow.  

9 Enter a filename BN3-finish-ted and then Save. 

10 Repeat the above procedure for the remaining two Toolpaths providing suitable file 

names. 

11 Browse to the C:\Temp directory to see the saves toolpaths. 

 

 

All the post-processed Toolpaths have been saved outside ArtCAM and translated in the 

format required for an Axyz machine controller. These files can now transferred to the 

machine controller itself, ready for manufacture. 

 

  If the Toolpath itself is modified within ArtCAM, the above process must be 

repeated for that specific file. 

  C:\Temp as a location is not recommended for production. A structured folder 

system according to best practice must be utilised.  

 

12 Do not close the model as it is required again in the next section. 
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Post Processing of Toolpaths for an Automatic Tool Changer 

 

If a Machine Tool is fitted with an Automatic Tool Changer then the control of this 

feature will be available in the Post Processor translation. 

 

If toolpaths containing different tools are passed over to the right hand window of the 

Save Toolpaths form and the selected Post Processor does not support an Automatic 

Tool Changer then a box with an error message will appear. 

 

1 Using the arrow Transfer all the toolpaths into the right hand window as shown. 

 

 

 The Vertical arrows can be used to reorder the toolpaths for a single output file.   

 

2 Ensure the same machine output file is selected as before. 

3 Select Save to output the combined files. 

 

 

 

The operation has failed and the above error message appears. The files were unable to 

be processed for two reasons. 

 

 The selected Machine (post processor) does not support tool changing itself.  
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 All tools are currently identified as Tool number 1.  The Tool Number is essential to 

identify the location of an individual Tool in the tool changer or carousel. 

 

The Tool Number can be specified in a number of ways. 

 Entering the tool number within the defined tool of the toolpath.  The Toolpath 

must be recalculated. 

 

 Entering/Editing the default tool number defined in the Tool database. 

 

 The quickest way is to change the tool number by first highlighting the tool in the 

Toolpaths Project Panel. 
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 Then changing the Tool number in the lower window before selecting Apply.   

 

4 Use any of the methods described above to assign different Tool numbers as shown 

in the image below. 

5 Select Save Toolpaths  from the Toolpath Operations area. 

6 Move all the Toolpaths to the right hand window. 

7 Reorder the Toolpaths as required. 

 

 

 

8 Enter file name as Machine Ted. 

9 Change the Machine output file to Axyz_MultiTool_Arc_MM.  

10 Select Save. 

 

 No Error message is displayed and now allows the files to be saved as one. 

 

11 Browse to the C:\Temp directory to see the saved toolpaths. 

 

 NC code can be viewed in WordPad for analysis or editing if required. 
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12 Right mouse click on the Toolpath Machine Ted an open with WordPad. 

 

 

The outputted NC code can be viewed. 
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